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Cash Receipts Module

Overview

Cash Receipts Module Setup

There are several features and settings that must be set up and defined before you can

generate receipts in the Cash Receipts module. Setups include creating operators, work-

stations, slips and payment methods.

Cash Receipts Module Security

Cash Receipts module security allows you to limit and control:

l Which Springbrook users can create receipts

l Which workstations can generate receipts

l Which users can generate receipts on a specific workstation

l How users access the Cash Entry window

l The number of users that can generate receipts in a single batch

Receipts
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The Cash Entry window is used to enter receipts (payments on customer accounts), gen-

erate type code charges and create a cash deposit on UB customer accounts. Receipts

can be created using a customer record, a customer record and a module account (for

example, UB), multiple customer records and customer accounts or no customer account

at all.

Utility Billing Module

The Cash Receipts module can be used to enter payments and create Cash Deposits on

Utility Billing module accounts. Payments on Utility Billing accounts are entered into the

Enter Cash Receipts window just like any other payment. The Detail tab of the Cash Entry

window will display all of the service rates, fee codes and taxes that are included on a cus-

tomer balance being paid. When a payment is made on a Utility Billing account in a Cash

Receipts batch, the process will force you to print a UB Proof List. The UB Proof List will dis-

play all 20 services and the payments made on each service on each receipt.

Cash Deposits on Utility Billing customer accounts can also be created from the Cash

Receipt module. Create a CR module type code in CR> Maintenance> Type Code Main-

tenance that has the same code as a deposit type fee code in the Utility Billing module in

UB> Maintenance> Fee. The CR type code must also be set up as a UB deposit by check-

ing the UB Deposit Type toggle in the Type Code Maintenance window.

You create the UB cash deposit in the Cash Entry window by adding the CR deposit type

code to the receipt. Type codes are added to receipts on the Detail tab of the Enter Cash

Receipts window.
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Type Code

Type codes create a single line item when they are added to a receipt on the Detail tab of

the Cash Entry window and have four main uses: charge for miscellaneous items such as

copy machine fees, create a deposit on a UB module customer account, record a cash

drawer over/short amount or record bank fees.

Category

A category code is a group of type codes. When a category is attached to a receipt all of the

fee codes attached to that category code will be added to the receipt. Category codes are

generally used to make entering cash receipts more efficient. Categories are created in

CR> Maintenance> Categories.

There are generally three uses of category codes:

l Group related type codes together that are usually charged together

l Example: tax or fee associated with a certain type code

l Charge multiple GL accounts during the receipt transaction

l Since type codes can only be associated with one debit and credit GL account, type

codes can be grouped together into a category code to charge multiple GL Accounts

during the receipt transaction.
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l Create a list of related type codes to choose from when entering a receipt

l Individual type codes can be removed from a receipt on the Detail tab of the Cash

Entry window.

Slips

Slips are receipts and endorsements that will print from a receipt printer when a receipt is

created in the Cash Entry window.  The term slip is a generic term that refers to both check

endorsements and receipts. The Slip Maintenance window (CR> Maintenance> Slip) is

used to create and maintain receipts and endorsements.

There are three ways to determine which slips will print out when a receipt is generated in

the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle in the Operator Maintenance window

(CR> Maintenance> Operator) to print all slips that are set up as default receipts in the Main-

tain Slips window (CR> Maintenance> Slip). If there are no default slips set up, no slips will

print.

l If the Automatically print receipt on save toggle is not checked in the Operator Main-

tenance window, the default slips will not print when receipts are saved in the Cash

Entry window.

l Slips attached to a payment method will print when that payment method is used on the

receipt. Slips are attached to payment methods in the Payment Method Maintenance window
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(CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to a check payment type so that the

endorsement will print when the check payment type is used on a receipt.

l Slips attached to a type code will print when that type code is added to a receipt. Slips are

attached to type codes in the Type Code Maintenance window (CR> Maintenance> Type

Code).

All three of these methods can be used in conjunction, but the slips that are set up as

default slips in the Maintain Slips window will always print before the slips that are attached

to payment method or type code.

The slips will print on the printer set up on the workstation in the Station Maintenance win-

dow (CR> Maintenance> Station).

Display Cash Receipts

The Display Receipts window is used to locate receipts and modify receipts that are in

uncommitted batches.

Reports
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The Receipt Listing Report is used to create a filtered list of Cash Receipts module
receipts. The Receipt Listing report displays in the same format as the Cash Receipts

Proof List in CR> Cash Receipts> Proof List, but includes several filters to select the trans-

actions you would like to include on the report. The report will group and total receipts by

payment type (cash, check, other) as well as include the change and net cash paid on the

transaction. The filter options on the report allow you to include voided and uncommitted

transactions, as well as filter the report by date range, batch, receipt number range, work-

station, operator, category and type code.

The Cash Drawer Report will display a filtered list of receipts that can be grouped by
either the operator that created the transaction or the workstation that was used to create

it. The Cash Drawer Report does not display the detail line items on the receipt. If you

would like the detail line items of the receipts, run the Receipt Listing Report in CR>

Reports> Receipt Listing.

The Deposit Slip Report is generally used to help create a bank deposit slip for the cash
and check receipts of a selected day. The report is filtered by receipt date and includes

uncommitted transactions in case you commit your cash receipts batches after you gen-

erate a deposit slip. Receipts of payment type Other are excluded from the report so that

the Deposit Slip report does not include credit card receipts. Voided transactions are also

excluded from the report. All receipts paid with cash will be totaled on the report and each

receipt paid with a check can be individually listed on the report. Checks and cash are

totaled separately on the report.
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The Pay Method Report will group and total a filtered list of receipts by payment method.
The report displays the receipt number, receipt date, payment method, operator, station,

amount and change. The change column is the amount of change returned on the trans-

action.

The Category List Report will display a Category Code, all of the Types that are attached
to the Category and the type code amount.  This report can be filtered to display only a cer-

tain range of category codes.

The Type List Report will display a list of type codes and type code information including
the Type Code, description, GL account numbers associated with each type code and the

dollar amount associated with the type code. All type codes, including those that are inact-

ive, will display on the report. The Type List report will not include the Project Management

module task or type code attached to the type code.

The Batch Summary Report is used to display Cash Receipts batches grouped by work-
station or operator. The report contains the batch number, batch date, batch status (com-

mitted or uncommitted), number of receipts in the batch and batch total.  Each batch

displays on the report as a single line item, so the report does not display the receipt detail.
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CR Setup Overview

All of the following must be set up before receipts can be entered into the Cash Receipts

module.

l All computers that will be used to enter receipts need to be set up as workstations.

l Workstations are created and maintained using the Station Maintenance window (CR>

Maintenance> Stations). You can only maintain the setup of the workstation you are

logged into. If you need to set up multiple workstations, you will have to log into each of

them.

l Every Springbrook user that will enter receipts must be set up as an operator in the Cash

Receipts module.

l Operators are created and maintained using the Operator Maintenance window (CR>

Maintenance> Operators).

l Each operator must be set up on the workstations they will use to enter receipts. Operators

will only be able to enter receipts on workstations they are set up on.

l You can attach a workstation to an operator using the Operator Maintenance window

(CR> Maintenance> Operator), or you can attach an operator to a workstation using

the Station Maintenance window (CR> Maintenance> Station). It doesn’t matter which

record you update (station or operator) because updating one will update the other.
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l An additional level of security can be set up by checking the Require operator reau-

thentication toggle on the CR Setup window (CR> Utilities> Setup).

l This will require that users log in a second time before accessing the Cash Entry win-

dow.

l Create the slips you would like to generate when a payment is entered.

l Slips are created and maintained using the Slip Maintenance window (CR> Main-

tenance> Slip).

l Create a list of payment methods. When a receipt is created, the payment method (cash,

check, credit card, etc.) is selected from a drop-down menu.

l Payment methods are created and maintained in the Payment Method Maintenance

window (CR> Maintenance> Payment Method).

l Determine which slips should print when receipts are generated. Slips can be attached to

payment types, type codes or set up as default slips which will print out for all receipts when

the Automatically print receipt on save toggle is checked in the Operator Maintenance

window (CR> Maintenance> Operator).

l Slips are attached to payment methods in CR> Maintenance> Payment Method. Slips

attached to a payment method will only print when that payment method is used on a

receipt.

l Slips are attached to type codes in CR> Maintenance> Type Code. Slips attached to a

type code will only print when that type code is attached to a receipt.
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l Slips set up as default slips on the Slip Maintenance window in CR> Maintenance> Slip

will print with each receipt generated by an operator when the Automatically print

receipt on save toggle is checked on the Operator Maintenance window (CR> Main-

tenance> Operator).

l Receipt options, such as printing duplicate slips, should be set up on the operator record.

l Slip options are set up on the operator in CR> Maintenance> Operator.

l Cash drawer and printer port options must be set up on the workstation.

l Stations are created and maintained in CR> Maintenance> Station.

l Set up the Cash Receipts module. The Setup window is used to set up receipt, interface,

security, and detail information.

l The Cash Receipts module is set up in CR> Utilities> Setup.

l Optional setups include type codes, category codes and type codes that can be used to cre-

ate UB module deposits.

l Type codes are created in CR> Maintenance> Type Codes.

l Category codes are groups of type codes and are created in CR> Maintenance> Cat-

egory Codes.

l After the module has been set up you should set security on the module to limit how receipts

are generated.
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Cash Receipts Module Security Overview
Operators-Limit which Springbrook users can create receipts

Create Cash Receipts module operator accounts for all of the Springbrook application

users that will create receipts in the Cash Receipts module. Operators are Springbrook

application users that are set up to use the Cash Receipts module in CR> Maintenance>

Operator. A user must be set up as a Springbrook application user (SS> Security> User)

before a CR module operator can be created for that user.

Stations-Limit which workstations can generate receipts

Create station records for all of the workstations that operators will use to create receipts in

the Cash Receipts module. Stations are generally the workstations that are attached to

cash drawers and receipt printers. Stations are created and maintained in CR> Main-

tenance> Stations, and the station record contains CR setup information such as cash

drawer codes and printer information. A station record can only be created and maintained

from that workstation.  Users cannot modify or create stations for workstations they are not

logged into.

Stations and Operators-Limit which users can generate receipts on a workstation

Users are attached to stations, and stations are attached to users in order to limit which

users can generate receipts on which stations. The user/workstation relationship can be

set up using either the Operator Maintenance window (CR> Maintenance> Operator) or the
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Station Maintenance window (CR> Maintenance> Station). If a user is attached to a station

using the Operator Maintenance window, that information will also display on the Station

Maintenance window.

Enter Receipts versus Cash Entry-Limit how users access the Cash Entry window

The Cash Entry window is used to generate all receipts in the Cash Receipts module and

there are two ways to access it: (CR> Cash Receipts> Enter Receipts) or (CR> Cash

Receipts> Cash Entry).

If the Cash Entry window is accessed through CR> Cash Receipts> Enter Receipts, the

Enter Receipts window will display all of the receipts in a batch, and allows users to select

and void receipts. If users should not have access to receipts that have already been cre-

ated, menu security (SS> Security> Menu Security) can be used to remove access to the

Enter Receipts menu option. Users can then access the Cash Entry window using the CR>

Cash Receipts> Cash Entry. The Cash Entry option will open a blank Cash Entry window

each time a receipt is saved. This option does not allow the user to view all of the receipts

that have been generated in the batch, and only allows a user to void the receipt they are

generating.

Single Operator per batch CR setup toggle-Limit each batch to a single user
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The Single Operator Per Batch toggle (CR> Utilities> Setup) limits each Cash Receipts
batch to a single user. Once there have been receipts created in a batch, other users will

not be able to create receipts in that batch. Operators that are set up as Managers (CR>

Maintenance> Operators> Manager toggle) will be able to open, modify and create
receipts in any batch.
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Cash Entry Window

Shortcuts/Hotkeys
The shortcut keys on the Cash Entry window are designed to replace actions that are reg-

ularly performed in order to reduce data entry.

ALT + A Open the Account/Category tab.
ALT + B Open the BP Permitting window.
ALT + C Add a Category to the receipt.
ALT + D Open the Detail tab.
ALT + K Open the cash drawer.
ALT + L Open the LP Licensing window.
ALT + N Open the Message/Notes tab.

ALT + P Print a slip. This allows you to print a specific slip for the receipt open in the
Cash Entry window.

ALT + R Print the receipt. This will print all of the slips attached to the receipt.
ALT + S Pay down interest and principal on an SA assessment.
ALT + U Open the Audit Trail window.

ALT + V
Press ALT + V to void the current receipt in the Cash Entry window. If the Cash
Entry window does not display a receipt, press ALT + V to void the last receipt
entered in the window.

ALT + X
Deselect all line items on the Detail tab. Use this shortcut to clear all of the val-
ues in the Amount to Pay column. This is the same as clicking the Deselect All

icon at the top of the Cash Entry window.

ALT + Y

Select all line items on the Detail tab when the Detail tab is open. Use this short-
cut if the customer is paying the amount due on all line items on the receipt.
This will set the Amount to Pay column equal to the Amount Due column. This is

the same as clicking the Select All icon at the top of the Cash Entry window.
CTRL + B Enter Scan Mode to enable a connected barcode scanner.
CTRL + E Exit Scan Mode to return to standard keyed entry.
CTRL + T Launch Pay with Terminal payment entry mode.

F11 Pay all line items on the receipt using the payment method titled Cash.
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F12 Pay all line items on the receipt using the payment method titled Check.

INSERT

Press INSERT when the Account/Category tab is open to add a customer
account to the receipt (this will open the Customer Accounts window). Press
INSERT when the Detail tab is open to add a CRmodule type code to the
receipt (this will open the Type Code Selection window).

ALT + INSERT
Calculates the remaining amount due and enters a payment for that amount.
The default payment method is Check, but this can be changed before the pay-
ment is saved.
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CivicPay Pad

CivicPay Pad Credit Card Terminal Setup
Springbrook now supports organizations that want to use point-of-sale credit card ter-

minals to process credit card payments directly in Cash Receipts with our CivicPay Pad

solution. In order to activate this functionality, organizations need to implement CivicPay,

Springbrook's standalone payment processing solution, and complete the setup steps out-

lined below.

Step 1: Contact Springbrook and request a CivicPay implementation.

l The first step in setting up CivicPay Pad is to contact the Springbrook Sales team to discuss

CivicPay implementation schedules and service agreements. A CivicPay Project Manager

will work with your organization to ensure a successful implementation.

Step 2: Set up CivicPay Pad on your network.

l Once your CivicPay implementation is complete, you will receive your CivicPay Pad credit

card terminals. These Pax A80 terminals will be shipped to you directly from Bluefin, Spring-

brook's credit card processing partner.
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l These CivicPay Pad terminals will arrive pre-configured to securely communicate with

Bluefin's payment processing infrastructure. However, there are a few configuration steps

that you must complete in order to connect CivicPay Pad terminals to your network.

l Please download the Bluefin Client Implementation Guide for more information on how to set

up your Pax A80 terminal. Your CivicPay Project Manager will assist you with this process.

Step 3: Set up the CivicPay Pad interface in Springbrook.

l Once your CivicPay Pad credit card terminals are connected to your local network, you will

need to configure Springbrook to interface with the terminals. Each workstation used to

receive credit card payments must be configured.

l Set up your CivicPay Pad terminals in CR Setup. Your CivicPay Project Manager will walk

you through this process.

l Open the Card Terminals tab on the CR Setup window.

l Check the Enable Card Terminal Interface toggle.

l Select a Terminal Pay Method from the drop-down list.

l This will be the default payment method for all payments processed through

CivicPay Pad. While existing payment methods will display in the drop-down

menu, many organizations will choose to create a new payment method spe-

cifically for CivicPay Pad payments. Your CivicPay Project Manager will discuss

this with you during implementation.

l Pay methods are created and maintained on the Pay Method Maintenance win-

dow (CR> Maintenance> Pay Method).
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l The CivicPay Token field will display a long series of alphanumeric characters that

Springbrook will use to securely communicate with CivicPay. This value will be entered

by the CivicPay team and should not be edited.

l
Click the Save icon once the setup is complete.

l Set up a cash receipting workstation to work with CivicPay Pad.

l Open the Station Maintenance window and select the station CivicPay Pad should be

associated with.

l Stations are created and maintained on the Station Maintenance window (CR>

Maintenance> Station).

l The Terminal IP Address field is used to enter the static IP address assigned to the

CivicPay Pad credit card terminal.

l The Terminal Port field is used to enter the terminal port set up on the CivicPay Pad

credit card terminal.

l Once the Terminal IP Address and Terminal Port fields have been populated, use the

Check the Connection icon to confirm the system can successfully communicate

with CivicPay Pad. The connection test results will display in a pop-up window.

l After successfully setting up CivicPay Pad, you can begin processing credit card payments.
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CR> Cash Receipts> Import Receipts

Import Receipts in CR

Summary

The Import Receipts window is used to import payment data from CivicPay Online and third

party applications through a user-configurable import file.

This is a premium feature. Contact Springbrook support for more information.

Step by Step

1     Create a Cash Receipts batch. 

l Select the New Billing palette in CR> Cash Receipts. This will expand the Cash

Receipts palette and display the steps of the Cash Receipts process.

l Select New from the Cash Receipts batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Cash Receipts process, you can create a new

batch without affecting the transactions in the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the receipt or journal entry date of the transactions in the batch.

l The receipt date is entered when each receipt is generated and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report (CR> Cash Receipts>

GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Import the receipts. 

l Select the Configuration of the import file.

l The Configuration drop-down field will display all of the import configurations

created in the application.

l Import configurations are customized import layouts that will take the

data from an from a third-party application export file and reconfigure it

to meet Springbrook layout requirements.
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l Import file configurations are created and maintained on the Import Con-

figuration Maintenance window (SS> Maintenance> Import Con-

figuration).

l
Once a configuration is selected, you can click the Layout icon to display

additional information about the expected layout of the import file.

l If the import file does not match the expected configuration, the import

process will encounter an error and the file will not be imported.

l Select a Layout for the import file if you are importing a file formatted by a third-

party vendor.

l This field will only be enabled when importing a non-configurable import file.

l Enter a Receipt Date that will be associated with the imported receipts.

l This date can be edited on each individual imported receipt in the Receipts

step.

l Select a Pay Method that will be assigned to the imported receipts.

l The pay method can be edited on each individual imported receipt in the

Receipts step.

l This field will be disabled if the Use record pay method toggle is checked

below.

l Enter the File Name or click the field label to browse to the desired import file.

l Check the Use record date toggle to pull the receipt date from the contents of the

import file.

l If the system cannot recognize a receipt date on a specific line item in the

import file, or if this toggle is not checked, the value in the Receipt Date field

above will be used.

IMPORT RECEIPTS IN CR 24



l Check the Use record pay method toggle to ignore the pay method selected

above and instead use the pay method associated with the imported receipts.

l If this toggle is checked and an imported receipt does not include a valid pay

method, an error will occur and the import will not proceed.

l The pay method associated with the imported receipt can be edited on the

Receipts step.

l Check the Create one receipt for all lines in file toggle in order to allow users to

import all the individual lines in the import file into a single receipt. The resulting

receipt will include one receipt line item for each line in the import file.

l If a Pay Method is selected above, all line items will be aggregated and one

pay method line will be created for the total.

l If Use record pay method is checked above, all line items will be aggregated

by pay method and one total line will be created for each pay method.

l When this toggle is checked, the Use record date toggle will be disabled and

the imported receipt will use the Receipt Date specified above.

l
Click the Confirm icon to import the file.

l If the import file includes any UB accounts that are in Delete status, a warning

message will appear on the import step. This warning message is inform-

ational only and will not prevent you from importing the receipts.

3     Process the CR Receipts batch. 
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Cash Entry Window

Enter a Receipt

Summary

The Cash Entry window is used to enter payments on customer accounts, generate

charges using Cash Receipts module type codes or category codes and create cash depos-

its on UB customer accounts. This document will cover entering a payment.

Payments can be received in the Cash Receipts module for charges generated in any of

the other modules. For example, the Cash Receipts module is used to receive payments

on Utility Billing customer accounts. Payments are entered into the Cash Entry window,

which can be accessed through CR> Cash Receipts> Receipts> New, or through CR>

Cash Receipts> Cash Entry. Depending on how security is set up in the Cash Receipts

module, the Enter Receipts option may not be available on the Cash Receipts palette.

The Cash Entry window allows you to enter payments on all accounts attached to a cus-

tomer record. For example, if a customer has UB customer accounts 000001-001, 000001-

002 and 000001-003, the balance on all of those accounts can be paid on a single receipt.

This also applies to accounts in other modules. For example, if a customer has multiple UB

and AR module accounts, the balance on all of those accounts can be paid on a single

receipt.
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The Cash Entry window can also be used to enter payments on multiple customers. For

example, if a customer would like to pay the balance on their own UB account and a UB

account that is not in their name, you can use the Cash Entry window to generate a single

receipt that pays the balance of both accounts.

The receipts/endorsements that will print when the transaction is complete depend on how

the Cash Receipts module is set up. Receipts/endorsements can be attached to payment

methods, type codes and set up as defaults on the Slip Maintenance window (CR> Main-

tenance> Slip).

In order to create a receipt using the Cash Entry window, you must be set up as an oper-

ator in the Cash Receipts module (CR> Maintenance> Operator), the computer you are

using must be set up as a CR module station (CR> Maintenance> Station) and you must be

set up as an authorized user on the station you are logged into (CR> Maintenance> Sta-

tion> Authorized Users section).

Step by Step

1     Open the Cash Entry window. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).

l The Cash Entry window can be opened from two separate palette options: Enter

Receipts or Cash Entry.
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l The Receipts item on the Cash Receipts palette will display all of the receipts

that have been entered in a batch. This allows you to open and modify all of

the receipts in the batch.

l
Click the Show Batch Totals icon to open an informational window that will

display Cash, Check, Other, Change and Batch totals for the active receipts

included in the batch. Totals will not include voided receipts.

l The Cash Entry menu item will open the Cash Entry window but only allow

users to view the receipt being generated.

l Menu security (SS> Security> Menu Security) can be set up on the Cash

Receipts palette to disable one of the palette options.

l Receipts can be voided through both of these windows as well.

l
From the Receipts window, simply click the Delete icon or press DELETE

to void a receipt that is included in the batch.

l From the Cash Entry window, the last receipt entered can be voided by click-

ing the Void Previous Receipt icon .

l Void functionality can be secured through the Menu Security and Data-

base Security windows.

l To allow an operator access to only the Void Previous Receipt

option on the Cash Entry window, the operator must be denied

access to the Enter Receipts window. This can be achieved by

setting Menu Security for CR> Cash Receipts> Receipts to No

Access for the desired user or user group.
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l To prevent an operator from accessing void functionality entirely,

Database Security for CR> CR Receipt> Void must be set to No

Access for the desired user or user group.

l
Highlight a receipt and click the Modify icon or press ENTER to edit an existing

receipt.

l
Click the Create icon or press INSERT to create a new receipt for the batch.

This will open the Cash Entry window.

2     Select a customer record. 

l The customer selected in the Customer Information section is the customer paying

the receipt. The customer selected in this section will display on the receipt if the

receipt is set up to display customer information. Selecting a customer will also pop-

ulate the Cash Entry window with all of the customer accounts attached to the selec-

ted customer. For example, if customer 000005 has UB module account 000005-

001 and 000005-002, selecting customer 000005 will add UB account 000005-001

and 000005-002 to the receipt. If customer account 000005-002 should not be

included on the receipt, it can be removed using DELETE.

l If a customer is paying down the balance of another customer’s account, you

can enter the paying customer’s information in this section if you would like

that customer to display on the receipt. For example, if customer 000001 is

paying down the balance on UB customer account 000008-001, you can

select customer 000001 in the Customer Information section. The customer
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information attached to customer record 000001 will display on the receipt,

not the customer information attached to customer account 000008-001.

l If you do not want to add a customer to the receipt, you can leave the Cus-

tomer Information section blank. For example, if a customer is using the copy

machine in the lobby you can leave the Customer Information section blank.

The customer information will not display on the receipt. If you leave the Cus-

tomer Information section blank you can add customer accounts to the receipt

using the Category tab.

l Click the Customer Number field label to select a customer record from a list. This

will open the Customer Accounts window.

l The Customer Accounts window is used to select a customer record, or a cus-

tomer record and customer account. For example, if customer 000007 is pay-

ing off the balance on all their customer accounts, select only customer

000007. If customer 000007 is only paying the balance on UB customer

account 000007-001, select the customer, hold down CTRL, and select UB

customer account 000007-001.

l The customer information will populate in the Customer Information section after it

has been selected.

l You can also scan in the customer, account and payment information. This requires

that your workstation be set up to use a barcode scanner and your customer pay-

ments include a payment stub with the appropriate barcode information. Once you

scan in the payment details, you can follow the steps below to edit the payment

information in the same manner as a manually entered payment.

l If the Save On Scan option is selected from the Options menu above, the sys-

tem will automatically save the scanned payment information. Once a pay-

ment receipt is scanned and saved, the system is ready to receive the next
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scanned payment. This allows you to quickly enter a large number of pay-

ments without spending time on inefficient data entry.

l If you need to scan multiple payment receipts for each account, the

Save On Scan option must be off.

l The Amount entered on the receipt will default to the amount of the bill. The

Pay Method on the receipt will default to the pay method set up as the default

on the CR Setup window (CR> Utilities> Setup> Default Pay Method field).

3     Select the customer accounts to pay on the receipt. 

l The Account/Category tab is used to add and remove the specific customer

accounts that will be paid on the receipt.

l The Account/Category tab is also used to add a category code to a receipt.

l This tab may have populated with customer accounts based on the selection in the

Customer Information section.

l Highlight a customer account and press DELETE to remove the customer account

from the receipt.

l
Click the Create icon drop-down menu at the top of the Cash Entry window to

add a new customer account to the receipt. Select Add Account from the drop-down

menu and the Customer Accounts window will open.

l Select a customer account using the Customer Accounts window. You can

select more than one customer account by holding down CTRL while high-

lighting the accounts.
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l The Amount Due will display the balance on each account included on the receipt.

l The Amount to Pay column will populate with the balance of each customer

account on the receipt.

l If you would like to enter a partial payment on a customer account you can enter the

partial payment amount in the Amount to Pay column on the Account/Category tab

or on the Detail tab.

l If you enter a partial payment on a Utility Billing module account on the

Account/Category tab, the amount of the partial payment will be applied to the

services attached to the UB customer account based on the UB setup. For

example, UB customer account 000001-001 has a balance of $35 in service

WATER, and $15 in service WASTE WATER. A partial payment of $20 is

entered on the receipt. The partial payment on the UB customer account will

be distributed based on the selection in the Payment Priority field on the

setup window (UB> Utilities> Setup> Payment tab). If Priority then Age is

selected, the partial payment will be distributed based on the services

attached to the account first. The payment priority of a service is set up in the

Payment Priority field on the Service Maintenance window. If the WATER ser-

vice has a payment priority of 1, and the WASTE WATER service has a pay-

ment priority of 2, then the entire partial payment will be applied to the

WATER service. If the WATER and WASTE WATER service have the same

priority, then the partial payment will be applied based on the age of the bal-

ances in those services.

l If you enter the partial payment on the Detail tab, the partial payment will be

manually distributed to each service on the receipt rather than automatically

distributed based on the UB module setup.
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l If you would like to enter an overpayment on a specific customer account, enter the

overpayment amount in the Amount to Pay field. You can also enter overpayments

on the Detail tab.

l If the customer account is a Utility Billing account, the overpayment will be

applied to each customer account based on the how the UB module is set up.

If Fixed Percentage is selected in the Overpayment Distribution drop-down

on the Setup window (UB> Utilities> Setup> Payment tab), the overpayment

will be applied based on the overpayment percentages set up on each service

on the receipt.  Overpayment percentages are set up on services on the Ser-

vice Maintenance window (UB> Maintenance> Service> Overpay Percent

field).

l If Last Bill is selected in the Overpayment Distribution drop-down menu (UB> Util-

ities> Setup> Payment tab), the overpayment will be applied to the receipt based on

the distribution of the last bill. For example, if WATER service was $30 and WASTE

WATER service was $15, 66% of the overpayment will be applied to the Water ser-

vice and 33% of the overpayment will be applied to the WASTE WATER service

(30/45 = 66%, and 15/45=33%).

l If you enter overpayments on the Detail tab, the overpayment will be manually

applied to each service on the receipt rather than automatically distributed

based on the UB module setup.

l If the account selected is a UB account in delete status, a warning message will be

displayed when you attempt to save the receipt. This warning message is inform-

ational only and will not prevent you from processing the receipt.

4     The Detail tab is used to add or remove specific line items from the receipt. 
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l The Detail line item will display the detail line items on the receipt. For example, if a

UB module customer account is attached to the receipt, the services (Water, elec-

tric, gas, etc.) being paid on the receipt will display as separate line items on the

Detail tab.

l Highlight a detail line item and press DELETE to remove it from the receipt.

l The customer attached to each customer account will display in the Customer

Number column. If there are multiple customers and customer accounts on the

receipt, make sure you are modifying the correct ones.

l The Account/Category column will display the customer account number or cat-

egory code used to create the detail line item.

l The Amount Due field will display the amount due on each detail line item on the

receipt.

l The Amount to Pay column displays the amount that will be paid on each line item.

Modify the amount in this column to apply an overpayment or partial payment to the

line item. For example, if customer account 000001-001 has WATER and WASTE

WATER services, but the customer only wants to make a payment on the WASTE

WATER service, enter the payment amount in the line item created by the WASTE

WATER service.

l
Click the Create icon drop-down menu and select Select Type to attach a type

code to the receipt.

l Type codes are used to add fees to receipts. Type codes are created and

maintained on the Type Code Maintenance window (CR> Maintenance> Type

Code).
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l
Click the Create icon drop-down menu and select Quick Enter Type to open

the Quick Type Entry window.

l The Quick Type Entry window is an alternate way of attaching a type code to

a receipt while minimizing data entry.

l
Click the Add Credit/Deposit icon drop-down menu and select Add New Credit

or Deposit. This will open the Add Credit/Deposit window.

l Credits and deposits can only be added to AR, BP and LP accounts. In order

to populate the Account/Category tab below with the appropriate AR, BP or

LP account, open the Search tab and click an AR, BP or LP number field label

to select the account from a list.

l Select a Tran Type from the drop-down menu to specify what type of fee you

will be adding to the account.

l Select CreditCash to add a credit fee to the account.

l Select Deposit to add a deposit fee to the account.

l Enter a Fee Code or click the field label to choose one from a list. Fees con-

tain the detail information for each line item.

l If Fee Selection window does not display any available fee codes for the

selected transaction type, you will need to create an appropriate fee

code before proceeding.

l Enter an Amount for the credit or deposit fee.

l
Click the Save icon to add the credit or deposit fee to the Detail tab.

l
Click the Delete icon to remove the selected credit or deposit.
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l
Click the Add Credit/Deposit icon drop-down menu and select BP Permitting to

create a Building Permits application or permit. This will open the BP Permit Main-

tenance window.

l
Click the Add Credit/Deposit icon drop-down menu and select Calculate BT

Interest to apply interest to any BT line items with outstanding balances listed on

the Account/Category tab. This will create a new line item on the Detail tab that dis-

plays the interest amount applied to the BT outstanding balance.

l The interest amount is determined by the Interest Fee that is attached to the

BT return Tax Type.

l Interest Fees are created and maintained on the Fee Maintenance win-

dow (BT> Maintenance> Fee).

l Interest Fees are then attached to Tax Types on the Tax Type Main-

tenance window (BT> Maintenance> Tax Type> Interest Code field).

l This option will not be enabled if the Automatically calculate interest in CR

toggle is checked on the BT Setup window (BT> Utilities> Setup).

l
Click the Add Credit/Deposit icon drop-down menu and select LP Licensing to

create a new license or application or to renew an existing license.

l
Click the Add Credit/Deposit icon drop-down menu and select SA Pay Down

Assessment to create a new assessment pay down on an assessment highlighted

in the Account/Category section below.

l
Click the Pay With Terminal icon to accept a credit card payment on the receipt.

5     Enter a message or note on the receipt using the Messages/Notes tab. 
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l The Messages/Notes tab is used to enter optional information on the receipt.

l Information entered into the Message 1 through Message 5 fields will only display

on the receipt if those fields have been added to the receipt. The Message 1 though

Message 5 fields are added to a receipt using the Slip Maintenance window (CR>

Maintenance> Slip).

l The Notes field will not display on the receipt.

6     Enter the payment and payment type. 

l The Total Due field in the Receipt Information section will display the total amount

due on the receipt based on the total of the receipt line items included on the

receipt. If this amount is incorrect, adjust the amounts of the detail line items using

the Detail tab.

l The Payments section is used to enter the payment on the receipt. If the customer is

using multiple payment types on a single receipt you can create as many line items

in this section. For example, if the customer would like to pay in cash and check,

you can enter a cash line item and a check line item in the Payments section.

l Enter a payment amount in the Amount column.

l Select the Pay Method from the drop-down menu.

l Payment methods are created and maintained in CR> Maintenance> Pay

Method.
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l If you are using a pay method that has an associated cash override account,

no other pay methods can be used on the receipt.

l If you are processing a counter receipt through a credit card terminal, see the Credit

Card Terminal Payments topic for details.

l The Reference field can be used to enter reference information on the payment line

item, such as a check number. This is an optional field and can be used to filter the

receipts that display in the Display Receipts window (CR> Maintenance> Display

Receipts).

l Press TAB to create the payment line item.

l If you would like to delete a payment line item, select the entire line item and press

DELETE.

l The Total Payments field in the Receipt Information section will display the total

amount of payment line items.

l If the Total Payments is greater than the Total Due, the Change Owed field will

display the amount of change that should be returned to the customer.

l If the customer would like to apply the Change Owed amount to the customer

account, increase the amount of a receipt line item on the Detail tab of the

Cash Entry window by the change amount. For example, if a customer is

owed $1.75 of change and they would like to apply that to the WATER service

on their UB customer account, increase the Amount Due on the WATER ser-

vice on the Detail tab.

7     Complete the receipt. 
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l Enter a Receipt Number in the Receipt Information section. The Receipt Number

field will be disabled and the receipt number will populate automatically when the

receipt is saved if the Cash Receipts module is set up to auto-number receipts.

l The Cash Receipts module is set up to auto-number cash receipts in CR> Util-

ities> Setup> Auto Number Receipts toggle.

l Enter the receipt date in the Date field. This field will default to the current date.

l Press ENTER to save the receipt when complete.

l The receipts that will print depend on how the Cash Receipts module is set up.

l If the Automatically Print Receipt on Save toggle is checked (UB> Main-

tenance> Operator> Maintenance section), the receipt printer will print all

receipts and endorsements set up as default slips on the Slip Maintenance

window (CR> Maintenance> Slip> Default Slip toggle), all slips attached to

payment methods used on the receipt (CR> Maintenance> Pay Method>

Slips section), and slips attached to any type code attached to the receipt.

l If the Automatically Print receipt on save toggle is not checked on the

Operator Maintenance window, the receipt printer will only print out the slips

that are attached to the payment type, and type codes on the receipt.

l The cash drawer will open automatically when the receipt is saved if the Open cash

drawer after save toggle is checked on the Operator Maintenance window (CR>

Maintenance> Operator). If the cash drawer does not open automatically, you can
click the Open Cash Drawer icon to open it manually.

8     Track any changes to the receipt. 

ENTER A RECEIPT 39



l
Click the Audit Trail icon to open the Cash Receipts Audit Trail window.

l The Audit Trail window is used to track any changes made to the receipt record.

l Use the Search Criteria section to sort the displayed audit history.

l The Audit Trail History section will provide details about any changes made to the

receipt record including the date of the change, type of change made, user that

made the change, and data table that was edited.

9     Add attachments to the receipt.

l
Click the Attachments icon to add or maintain any attachments associated with

the receipt. This will launch the Attachments Maintenance window.

10     Commit the Cash Receipts batch. 
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CR> Cash Receipts> Import Returns

Import Returns in CR

Summary

The Import Returns window is used to import Business Tax Module tax returns into the

Cash Receipts module.

Step by Step

1     Create a Cash Receipts batch. 

l Select the New Billing palette in CR> Cash Receipts. This will expand the Cash

Receipts palette and display the steps of the Cash Receipts process.

l Select New from the Cash Receipts batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Cash Receipts process, you can create a new

batch without affecting the transactions in the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the receipt or journal entry date of the transactions in the batch.
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l The receipt date is entered when each receipt is generated and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report (CR> Cash Receipts>

GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Import the returns. 

l Open the Import Returns window (CR> Cash Receipts> Import Returns).

l Select a Format for the import from the drop-down menu.

l
Click the Layout icon after selecting a format in order to see the expected file

contents.

l Enter a Tax Type or click the field label to select one from a list.

l Tax Types are used to group taxes together into logical associations such as

Payroll or Gross Receipts. Tax types are then attached to businesses and

used to calculate the tax amounts when returns are received in the Cash

Receipts module.

l Tax Types are created and maintained on the Tax Type Maintenance window

(BT> Maintenance> Tax Type).
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l Select a Period from the drop-down menu.

l Only periods attached to the selected tax type will display in this menu. Peri-

ods are attached to tax types on the Tax Type Maintenance window (BT>

Maintenance> Tax Type> Create New Schedule).

l Select the return year you would like to import in the Year field.

l Select a Payment Method from the drop-down menu.

l Pay methods are used to define what kind of payment is received when cre-

ating a receipt in the Cash Entry window. Pay methods are created and main-

tained on the Pay Method Maintenance window (CR> Maintenance> Pay

Method).

l Click the Input File field label to browse to the returns file you would like to import.

l
Click the Confirm icon to import the returns immediately or enter a date and time

in the field next to the Confirm icon to schedule the import to process at a later time.

You can view the progress of the import on the Job Viewer window (SS> Utilities>

Show Scheduled Jobs).

3     Process the CR Returns batch. 
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CR> Cash Receipts> Return Entry

Enter Returns in CR

Summary

The Return Entry step of the Cash Receipts process is used to enter tax return payments

into the application.

Step by Step

1     Create a new Cash Receipts batch. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).

2     Open the Return Selection window (CR> Cash Receipts> Return Entry). 

l The Return Selection window displays all of the returns that are included in the

batch.
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l
Click the Show Batch Totals icon to open an informational window that will

display the Calculated Amount Total and Amount Paid Total for the active

returns included in the batch.

l Click the Business Number to open the BT Business Maintenance window for

an existing return.

l
Click the Delete icon or press DELETE to delete the selected return.

l
Click the Modify icon or press ENTER to edit the selected return.

l
Click the Create icon or press INSERT to create a new return to add to the

batch. This will open the Return Maintenance window.

3     Create a new return. 

l The Invoice Number will be automatically generated when you save the return.

l Designate a Year for the return.

l Enter a Business Number or click the field label to select one from a list.

l Business numbers are codes used to identify each unique business and allow

a single customer record to be attached to multiple businesses. A business

number is automatically assigned to a business when it is created.

l The Federal Tax ID number, SSN and State ID number are all associated with the

business selected in the Business Number field. If you do not know the Business

Number, you could use the Social Security Number of the customer associated with

the business to create the return.

ENTER RETURNS IN CR 45



l The Federal Tax ID and the State ID numbers are associated with a business

on the General tab of the Business Maintenance window (BT> Maintenance>

Business> General tab).

l The SSN is attached to an account on the Customer Maintenance window

(Customer icon on the main application window> Social Security Number

field).

l The State ID field label is user defined and may not match the example

described here.

l The Name and Service Address fields will automatically populate with the cus-

tomer name and service address associated with the Business Number.

l Select a Tax Type from the drop-down menu.

l Tax Types are created and maintained in the Business Tax module (BT> Main-

tenance> Tax Type).

l Designate a Period for the return.

l Select a Receipt Date, Transaction Date and Due Date for the return.

l The Receipt Date and Transaction Date will both default to today's date. The

Due Date will default to the due date specified for the selected Tax Type.

l The Apply Discount field will only be active if the tax type associated with the selec-

ted business is discountable.

l Select Yes in order to apply the discount percentage set up on the tax type.

You will also need to apply the discount on the Edit Return window covered

below in Step 4.
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l Tax types are set up as discountable on the Tax type Maintenance field (BT>

Maintenance> Tax Type> enter a value greater than zero in the Discount Per-

cent field).

l The Extension Filed and Extension Date fields will only be active if the Allow

Extension toggle is checked on the Tax Type Maintenance window.

l Select Yes from the Extension Filed drop-down menu to file an extension for

the return. The Extension Date field will display the extended date specified

for the selected Tax Type, but this date can be edited.

l
Click the Add Infraction icon or press INSERT when in the Infractions field to

add an infraction to the return. This will open the Infraction Type Selection window.

l Infraction types are used to track infractions against filed tax returns, but are

not generally associated with monetary penalties. Infraction Types are cre-

ated and maintained on the Infraction Type Maintenance window (BT> Main-

tenance> Infraction Type).

l Enter an optional Description for the return.

l Select a Payment Method from the drop-down menu.

l Payment methods are used to define what kind of payment is received when

creating a receipt in the Cash Entry window. Pay methods are created and

maintained on the Pay Method Maintenance window (CR> Maintenance> Pay

Method).

l If you are using a pay method that has an associated cash override account,

no other pay methods can be used on the receipt.

l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.
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l The Payment Reference field can be used to enter reference information on the

payment line item, such as a check number. This is an optional field and can be

used to filter the receipts that display in the Display Receipts window (CR> Main-

tenance> Display Receipts).

l The Calculated Amount field will automatically populate with the total from the Cal-

culated Amount column in the Line Items section below.

l Enter a Payment Amount for the return.

l The Return Balance field will display the amount owed on the return.

l The Credit Amount field will display any overpayment on the return.

l The Business Balance field will display the current outstanding balance for the

selected business. If this field is populated, you may want to investigate which tax

type periods are responsible for the balance and apply return payments to those

periods first.

4     Add Fees to the return. 

l
Click the Create icon or press INSERT to add fees to the return. This will open

the Fee Selection window.

l Fees are user-defined codes used to generate an associated transaction on a

business account. Fees are attached to tax types and then tax types are used

to assess taxes on businesses.

l Fees are created and maintained on the Fee Maintenance window (BT> Main-

tenance> Fee).
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l
Select a fee and click the Confirm icon or press ENTER to add that fee

and open the Edit Return Fee window.

l The Edit Return Fee window will display the Fee code, Fee Type and

Unit Type, if specified, for the selected fee.

l If the fee is a unit type fee, enter the Number of Units and the

Excluded Units to determine the total units that will be subject to the

fee.

l If the tax type associated with the return is discountable, you can select

Yes from the Discountable drop-down menu in order to apply a dis-

count to the fee. The Discount Amount and Calculated Amount fields

will update accordingly.

l Enter a Line Pay Amount and press ESC to return the fee to the Line

Items section. You do not need to save this form as it saves auto-

matically.

l If the Omit Units toggle is checked on the Tax Type selected above,

the units fields will be disabled and the unit information will not display

on the fee line item.

l The Line Pay Amount cannot exceed the value in the Calculated

Amount field.

l You can also calculate penalty and interest amounts on the fee.

Choose Penalty or Interest from the Calculate icon drop-down menu

or press F2 for Penalty or F3 for Interest.
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l As with standard fees, selecting a penalty or interest fee and

pressing ENTER will open the Edit Return Fee window where you

can specify a Line Pay Amount for the selected fee.

l
To quickly process payments on the return click the Calculate icon drop-

down menu and select Set Line Pays as Cash Payment or Set Line Pays.

l This will automatically record full payments on all return line items, save

the return and reset the Edit Return window so the next return can be

entered.

l Set Line Pays as Cash Payments will set the Payment Method field to

Cash. Set Line Pays will set the Payment Method field to the default pay-

ment method set on the CR Setup window (CR> Utilities> Setup>

Default Pay Method field).

l Set Line Pays as Cash Payment can also be selected by pressing F11

and Set Line Pays can be selected by pressing F12.

l As you add fees to the return, the Calculated Amount and Return Balance fields

will automatically update.

l Overpayments will credit the Credit Fee specified on the BT Setup window (BT> Util-

ities> Setup> Credit Fee field).

l
Click the Save icon when complete.

5     Generate a Proof List. 
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l The Cash Receipts Proof List Report will display all of the return line items attached

to the returns in the batch totaled by payment type (cash, check, other).

l Open the Proof List window (CR> Cash Receipts> Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l Select Detail to display a separate line item for detail line item on the receipt.

The detailed version of the report shows the receipt number, whether or not

the receipt was voided, customer number, date, customer name, cash receipt

type, description, receipt amount, and the amounts for cash, check, other,

change, net cash, and total.  Each receipt is totaled, and the report has a

grand total.

l Select Summary to display a single summary line item for each receipt.  The

report shows the receipt number, whether or not the receipt was voided, cus-

tomer number, date, customer name and the amounts for cash, check, other,

change, net cash and total.  There is a grand total for the report.

l Select how the report should be sorted in the Sort By drop-down menu.

l Select Customer Number if you would like to sort the receipts that display on

the report by the customer number attached to the receipt.

l Select Receipt Number if you would like to sort the receipts that display on the

report by receipt number.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l If the Cash Receipts Proof List was generated in detail format the report will display

the receipt number, customer information, and the service rates and fee codes paid

on the receipt.

l The Type column will display Service if the receipt line item reduces the bal-

ance on a service. If the receipt line item is paying a fee code, the Type

column will display Fee. If the receipt line item is creating a cash deposit, the

UB module deposit fee code will display in the Type column.

l If you generate in summary format, the report will display the receipt totaled

by payment type.

6     Generate a BT Return Proof List. 
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l Open the BT Proof List window (CR> Cash Receipts> BT Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l The Summary report will display the Receipt number, Invoice number, Busi-

ness number, Business Name, Calculated Amount, Payment Amount, Receiv-

able Amount, Credit Amount, Deposit Amount and totals for each amount.

l The Detail report will display everything included in the summary report as

well the Fee, Fee Type, Unit Type, Number of Units, Excl Units and Subj

Units.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

7     Print a GL Distribution List. 
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l The GL Distribution Report will display the debit and credit amounts created by the

return line items included in the batch.

l Voided receipts will not display on the report since they will not affect the general

ledger.

l Select GL Distribution on the Cash Receipts palette. This will open the GL Dis-

tribution Report window.

l The Journal Entry field will determine the fiscal period and fiscal year of the journal

entry generated by the batch.

l The journal entry date will default to the current date.

l The Fiscal Period and Fiscal Year fields are not enabled and will populate based

on the date entered in the Journal Entry field.

l Select the level of detail you would like to include on the report in the Report Type

drop-down menu.

l The Detail report will display the fund, general ledger account, general ledger

account description, receipt number, line item description, debits and credits.

The report will also group and total the report by fund and display report totals

of the debit and credit columns.

l The line item description of a receipt can be viewed in CR> Cash

Receipts> Enter Cash Receipts> Detail tab> Description column.

l The summary report will display the fund, general ledger account, general

ledger account description, debits and credits.  The report will also group and

total the report by fund and display report totals of the debit and credit

columns.
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the GL distribution report. If any errors are discovered on the GL Dis-

tribution list you may be able go back and correct the receipts. This depends on the

security settings for your system.

l The GL distribution will display the net distribution when quick permits and quick

licenses are created. Debits and credits that result in a wash will not display in the

report.

l If the GL Distribution report is run in detail format, the report will display the net

effect on the GL by receipt.  If there is a positive and negative receipt line item for

the same charge type or GL account, the report will display the net distribution on

the GL account, not the debit and debit to the same GL account.

l If a GL account has a debit and credit across different receipts, the report will
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display each line item on the GL account, not the net effect. The receipt line

items will only display as a net amount by receipt.

8     Commit the Cash Receipts batch. 

l The final step in the Cash Receipts process is to commit the batch.  Select Commit

on the Cash Receipts palette. This will open the Commit window.

l The Batch field will display the batch number of the batch being committed.

l The Journal Entry Date field will display the journal entry date entered on the GL

Distribution step.

l The Fiscal Period and Fiscal Year fields will populate based on the journal entry

date entered in the Journal Entry Date field on the GL Distribution step.

l Press ENTER or click the OK button to commit the batch.
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Cash Entry Window

Create a Receipt using a Category Code

Summary

Category codes are type codes grouped together and are created in CR> Maintenance>

Categories. Category codes are attached to receipts on the Account/Category tab of the

Cash Entry window. When the category code is attached to a receipt, each type code

attached to the category code will create a separate line item on the receipt and they will

display on the Detail tab of the Cash Entry window. The payment of the category code will

not display on a customer or customer account even if one is attached to the receipt. You

can generate reports in the Cash Receipts module to view payments on category codes but

the information will not display on or affect the balance of a customer account.

In order to generate a receipt from the Cash Entry window you must be set up as an oper-

ator (CR> Maintenance> Operator), the computer you are logged into must be set up as a

station (CR> Maintenance> Station), and you must be set up as an authorized user on the

station (either the Operator Maintenance window or the Station Maintenance window).

Step by Step

1     Open the Cash Entry window. 

CREATE A RECEIPT USING A CATEGORY CODE 57



l The Cash Entry window is used to enter payments.

l There are two ways to open the Cash Entry window: (CR> Cash Receipts> Enter

Receipts> INSERT), or (CR> Cash Receipts> Cash Entry). Some organizations

restrict access to the Enter Receipts menu option because it displays all receipts in

the batch. The Cash Entry menu option only displays the receipt that is being cre-

ated.

2     Create the receipt. 

l Select a customer and customer account if you would like that information to display

on the receipt. The payment of the category code will not affect the balance of the

customer account included on the receipt.

l You are not required to enter a customer number or customer account when

creating a receipt using a category code because the receipt will not affect

the customer account balance. The advantage of including a customer num-

ber on the receipt is that the customer information can be included on the slip

and will be included in Cash Receipts module reports.

l The customer information will only display on the receipt if there are cus-

tomer information fields attached to the slip that will print when the

receipt is printed.

l Slips are created in UB> Maintenance> Slip.

l Click the Customer Number field label to select a customer from a list. This

will open the Customer Accounts window.
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l If you select a customer number, all accounts attached to that customer

will populate on the receipt.

l Click the Expand button next to a customer record to view the customer

accounts attached to the customer record. Select a customer account to

only populate that account on the receipt by holding down CTRL and

selecting both a customer record and a customer account. Remember,

the balance of the selected customer account will not be affected by the

payment of a category code. Attaching a customer account to a receipt

allows you to pay the balance of a customer account at the same time

as entering payment on a category code, and adds the customer inform-

ation to the receipt.

l The fields in the Customer Information section on the Cash Entry win-

dow will populate with the customer record information. If customer

accounts were included on the receipt, each account will create a sep-

arate line item on the Account/Category tab of the Cash Entry window.

l Select the customer account balances to pay, or remove them from the receipt on

the Account/Category tab.

l All of the customer accounts attached to the receipt will display on the Accoun-

t/Category tab.

l Press INSERT to add another customer account to the receipt. This will

open the Customer Accounts window again.

l Highlight a customer account on the Account/Category tab and press

DELETE to remove the account from the receipt. This will not delete the

customer account or the amount due, it will only remove the account

from the receipt.
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l If the customer wants to make a partial payment on a customer account, enter

the payment amount in the Amount to Pay column. You can also adjust the

payment amount on the Detail tab.

3     Add the category code to the receipt. 

l
The Create icon at the top of the Cash Entry window has three functions when

the Account/Category tab is open: add customer accounts to the receipt, add a cat-

egory code to the receipt, or add UB accounts with amount. Make sure the Detail or

Messages/Notes tabs are not opened in the window because this will change the

function of the Create icon .

l
Click the drop-down arrow next to the Create icon and select Add Cat-

egory from the menu that will display. This will open the Category Selection

window.

l Select a category code from the Category Selection window and click the Con-

firm icon to add the category to the receipt. This will add the category to

the Account/Category tab and populate the Detail tab with all of the type

codes attached to the category code.

l Only active category codes will display in the Category Selection win-

dow. Categories are set up as active by checking the Active toggle on

the Category Maintenance window (CR> Maintenance> Category).

CREATE A RECEIPT USING A CATEGORY CODE 60



l To adjust the receipt amount of the category code you can either adjust the value in

the Amount to Pay field on the Account/Category tab or you can adjust the amount

paid on each type code attached to the category code on the Detail tab.

l If you lower the amount in the Amount to Pay field, The Cash Entry window

will not apply the reduction in the Amount to Pay field uniformly to all of the

type codes attached to the category code. The Cash Entry window will lower

the amount to be paid on the type codes attached to the receipt starting with

the last type code attached to the category code.

l Click on the Detail tab of the Cash Entry window to view the detail line items on the

receipt. Each type code attached to the category code will display as a separate line

item on the detail tab.

l Highlight a line item and press DELETE to delete the selected item off the

receipt.

l Modify the amount in the Amount Due field to modify the amount due on a

specific type code.

4     Receive payment on the receipt. 

l The Payments section is used to enter the payments on the receipt.

l Enter the amount of payment in the Amount column in the Payments section.

By default, the field will populate with the total amount due on the receipt

when the cursor is placed in the field.
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l If a customer wants to pay using multiple pay methods (cash and check

for example), you can create multiple payment line items in the Pay-

ments section.

l Select a Pay Method from the drop-down menu.

l Pay methods are created and maintained in CR> Maintenance> Pay

Method.

l If there are slips attached to the pay method they will print when the

receipt is saved.

l If you are using a pay method that has an associated cash override

account, no other pay methods can be used on the receipt.

l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.

l Verify the receipt date is correct.

l The receipt date is entered in the Date field in the Receipt Information sec-

tion. The receipt date is used on many of the Cash Receipts module reports.

l
Click the Save icon when complete to save the receipt.

l There are three ways to determine which slips will print out when a receipt is gen-

erated in the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle on the Operator Main-

tenance window (CR> Maintenance> Operator) to print all slips that are set up

as default receipts in the Maintain Slips window (CR> Maintenance> Slip

Maintenance). If there are no default slips set up, no slips will print.

l If the Automatically print receipt on save toggle is not checked on

the Operator Maintenance window, the default slips will not print when
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receipts are saved in the Cash Entry window.

l Slips attached to a payment method will print when that payment method is

used on the receipt. Slips are attached to payment methods in the Payment

Method Maintenance window (CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to the check payment

type so that the endorsement will print when the check payment type is

used on a receipt.

l Slips attached to a type code will print when that type code is added to a

receipt. Slips are attached to type codes in the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

l All three of these methods can be used in conjunction, but the slips that are

set up as default slips in the Maintain Slips window will always print before the

slips that are attached to payment method or type code.
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CR> Cash Receipts

Create a Receipt using a CR Type Code

Summary

A type code creates a single line item when added to a receipt on the Detail tab of the Cash

Entry window and has four main uses: charge for miscellaneous items such as copy

machine fees, create a deposit on a UB module customer account, record a cash drawer

over/short amount, or record a bank fee.

Step by Step

1     Create a new receipt in the Cash Entry window. 

l The Cash Entry window is used to enter payments.

l There are two ways to open the Cash Entry window: CR> Cash Receipts> Enter

Receipts> INSERT or CR> Cash Receipts> Cash Entry. Some organizations restrict

access to the Enter Receipts menu option because it displays all receipts in the

batch. The Cash Entry menu option only displays the receipt that is being created.

2     Create the receipt. 
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l Select a customer and customer account if you would like that information to display

on the receipt. The payment of the type code will not affect the balance of the cus-

tomer account included on the receipt unless the type code is creating a UB deposit.

l You are not required to enter a customer number or customer account when

creating a receipt using a type code because the receipt will not affect the

customer account balance. The advantage of including a customer number on

the receipt is that the customer information can be included on the slip and

will be included in Cash Receipts module reports.

l The customer information will only display on the receipt if there are cus-

tomer information fields attached to the slip that will print when the

receipt is printed.

l Slips are created in UB> Maintenance> Slip.

l Click the Customer Number field label to select a customer from a list. This

will open the Customer Accounts window.

l If you select a customer number, all accounts attached to that customer

will populate on the receipt.

l Click the Expand button next to a customer record to view the customer

accounts attached to the customer record. Select a customer account to

only populate that account on the receipt. Remember, the balance of

the selected customer account will not be affected by the payment of a

type code. Attaching a customer account to a receipt allows you to pay

the balance of a customer account at the same time as entering pay-

ment on a type code, and adds the customer information to the receipt.
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l The fields in the Customer Information section on the Cash Entry win-

dow will populate with the customer record information. If customer

accounts were included on the receipt, each account will create a sep-

arate line item on the Account/Category tab of the Cash Entry window.

l Select the customer account balances to pay, or remove them from the

receipt on the Account/Category tab.

l All of the customer accounts attached to the receipt will display on the Accoun-

t/Category tab.

l Press INSERT to add another customer account to the receipt. This will

open the Customer Accounts window again.

l Highlight a customer account on the Account/Category tab and press

DELETE to remove the account from the receipt. This will not delete the

customer account or the amount due, it will only remove the account

from the receipt.

l If the customer wants to make a partial payment on a customer account, enter

the payment amount in the Amount to Pay column. You can also adjust the

payment amount on the Detail tab.

3     Add a type code to the receipt. 

l Click on the Detail tab of the Cash Entry window.

l Press INSERT to select a type code from a list. This will open the Type Code Selec-

tion window.
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l
You can also click the Create icon at the top of the Cash Entry window,

but you must have the Detail tab opened because the functionality of the

Create icon changes depending on which tab is selected in the window.

l Only active type codes will display in the Type Code Selection window. Type

codes are set up as active by checking the Active toggle on the Type Code

Maintenance window (CR> Maintenance> Type Code).

l Adding a type code to the receipt will create a new line item on the Detail tab.

l When adding a type code that has an attached tax type to the receipt,

line items will be created for both the type code and the attached tax

type.

l Highlight a type code and press DELETE to delete if the type code was accidentally

added to the receipt.

l Modify the amount in the Amount Due field to modify the amount due on a type

code.

4     Receive payment on the receipt. 

l The Payments section on the Cash Entry window is used to enter the payments on

the receipt.

l Enter the amount of payment in the Amount column in the Payments section.

By default, the field will populate with the total amount due on the receipt

when the cursor is placed in the field.
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l If a customer wants to pay using multiple pay methods (cash and check

for example), you can create multiple payment line items in the Pay-

ments section.

l Select a Pay Method from the drop-down menu.

l Pay methods are created and maintained in CR> Maintenance> Pay

Method.

l If there are slips attached to the pay method they will print when the

receipt is saved.

l If you are using a pay method that has an associated cash override

account, no other pay methods can be used on the receipt.

l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.

l Verify the receipt date is correct.

l The receipt date is entered in the Date field in the Receipt Information sec-

tion. The receipt date is used on many of the Cash Receipts module reports.

l
Click the Save icon when complete to save the receipt.

l There are three ways to determine which slips will print out when a receipt is gen-

erated in the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle on the Operator Main-

tenance window (CR> Maintenance> Operator) to print all slips that are set up

as default receipts in the Maintain Slips window (CR> Maintenance> Slip

Maintenance). If there are no default slips set up, no slips will print.

l If the Automatically print receipt on save toggle is not checked on

the Operator Maintenance window, the default slips will not print when
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receipts are saved in the Cash Entry window.

l Slips attached to a payment method will print when that payment method is

used on the receipt. Slips are attached to payment methods in the Payment

Method Maintenance window (CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to the check payment

type so that the endorsement will print when the check payment type is

used on a receipt.

l Slips attached to a type code will print when that type code is added to a

receipt. Slips are attached to type codes in the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

l All three of these methods can be used in conjunction, but the slips that are

set up as default slips in the Maintain Slips window will always print before the

slips that are attached to payment method, or type code.
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CR> Cash Receipts> Enter Receipts

BP Permitting in CR

Summary

Permits and permit applications can be created from the Enter Cash Receipts window

using the BP Permitting window. This allows you to create a permit or application based on

a BP Permit Type template as cash is received for the permit or application.

In order to create a permit or application from the CR module, you must have a Permit Type

template set up and that template must include a fee that will be assessed when the applic-

ation or permit is created.

Step by Step

1     Open the Cash Entry window. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).

l The Cash Entry window can be opened from two separate palette options: Enter

Receipts or Cash Entry.
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l The Enter Receipts item on the Cash Receipts palette will display all of the

receipts that have been entered in a batch. This allows you to open and

modify all of the receipts in the batch.

l
Click the Show Batch Totals icon to open an informational window that will

display Cash, Check, Other, Change and Batch totals for the active receipts

included in the batch. Totals will not include voided receipts.

l The Cash Entry menu item will open the Cash Entry window but only allow

users to view the receipt being generated.

l Menu security (SS> Security> Menu Security) can be set up on the Cash

Receipts palette to disable one of the palette options.

l
Click the Delete icon or press DELETE to void a receipt that is included in the

batch.

l
Highlight a receipt and click the Modify icon or press ENTER to edit an existing

receipt.

l
Click the Create icon or press INSERT to create a new receipt for the batch.

This will open the Cash Entry window.

2     Create a new BP Permit. 

l
Click the BP Permitting icon drop-down menu and select BP Permitting. This will

open the BP Permitting window.
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l You are not required to specify a customer for the CR Receipt before creating

the BP Permit. The customer associated with the permit will be automatically

associated with the receipt. If no customer is associated with the permit, the

lot attached to the permit will be associated with the receipt.

l In order to create a BP Permit, you will need to set up at least one Permit Type. Per-

mit types act as permit templates and can reduce data entry by automatically pop-

ulating the permit with the permit type valuations, fees, and inspection types.

l Permit Types are created and maintained on the Permit Type Maintenance

window (BP> Maintenance> Permit Type).

l The Permit Type, Lot, and Permit Status fields must be populated before

the permit can be saved.

l Applications or permits that are created in the Cash Receipts module must

produce a receivable when created.

l If you are creating an application, the specified Permit Type must con-

tain at least one positive value fee with the Used By drop-down menu

set to Application.

l If you are creating a permit, the specified Permit Type can contain a pos-

itive value fee with the Used By drop-down menu set to either Applic-

ation or Permit.

l If the Notification toggle is checked, you will be required to attach a customer

to the permit. Any forms attached to the selected Permit Type Forms tab that

have the Print toggle checked will automatically print when the receipt is

saved.

l Check the Print permit on receipt save toggle if you would like to generate

a printed copy of the permit when the Enter Receipts step is complete.
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l
Click the Save icon to save the permit and return to the Cash Entry window.

l The permit information will be tentatively saved at this point, but the permit will

not be permanently saved in the BP module until the receipt is saved and the

Cash Receipts batch is processed.

l Any notifications that will be generated by permit approval steps will not

be generated until the Cash Receipts batch is committed.

l If the CR receipt is voided after being committed, the BP application or permit

that was created when the receipt was committed will be automatically

deleted.

3     Receive payments on the Permit. 

l The lot or customer information associated with the new permit or application will

populate the Cash Entry window.

l The Amount Due will display the balance on each account included on the receipt.

l The Amount to Pay column will populate with the balance of each account on the

receipt.

l
Enter a payment amount in the Payments section and click the Save icon to

save the payment.

4     Commit the cash receipts batch. 
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CR> Cash Receipts> Enter Receipts

LP License Entry in CR

Summary

Licenses and applications can be created or renewed from the Enter Cash Receipts win-

dow using the LP Licensing window. This allows you to create a license or application

based on an LP License Type template as cash is received for the license.

In order to create a license from the CR module, you must have a License Type template

set up.

Step by Step

1     Open the Cash Entry window. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).

l The Cash Entry window can be opened from two separate palette options: Enter

Receipts or Cash Entry.
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l The Enter Receipts item on the Cash Receipts palette will display all of the

receipts that have been entered in a batch. This allows you to open and

modify all of the receipts in the batch.

l
Click the Show Batch Totals icon to open an informational window that will

display Cash, Check, Other, Change and Batch totals for the active receipts

included in the batch. Totals will not include voided receipts.

l The Cash Entry menu item will open the Cash Entry window but only allow

users to view the receipt being generated.

l Menu security (SS> Security> Menu Security) can be set up on the Cash

Receipts palette to disable one of the palette options.

l
Click the Delete icon or press DELETE to void a receipt that is included in the

batch.

l
Highlight a receipt and click the Modify icon or press ENTER to edit an existing

receipt.

l
Click the Create icon or press INSERT to create a new receipt for the batch.

This will open the Cash Entry window.

2     Open the LP Licensing window. 

l
Click the LP Licensing icon drop-down menu and select LP Licensing. This will

open the LP Licensing window.
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3     Enter the License. 

l You must have a License Type template set up in order to use the LP Licensing win-

dow. License Types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l The LP Licensing window is similar to the General tab of the LP License Main-

tenance window (LP> Maintenance> License).

l Click the Operation drop-down menu to specify whether this will be a new applic-

ation, a new billing, a new license or a license renewal.

l When renewing an existing license, the License Number field is the only field

on the LP Licensing window that will be active. Once a license is selected, you

will be able to update the license details and create an invoice for the renewal.

l Click the Category drop-down menu to select Business, Pet or Vehicle as the cat-

egory for the license.

l The Category selection will determine what information is displayed to the

right.

l Click the License Type field label to specify a license type for the license or applic-

ation. Every license or application must be associated with a license type.

l License types make creating licenses simpler and less time consuming.

License types dictate the fee codes and forms that will be used on the license.

By creating a number of different license types based on these char-

acteristics, you are not required to attach fee codes, forms, and other mis-

cellaneous information to each license you create. You simply attach the

license type to the license that should contain this information.

l After selecting a license type, the Fees and Forms sections below will pop-

ulate with the fees and forms attached to the selected license type.
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l The use of license types also allows you to classify similar licenses with each

other for reporting purposes. License types are created and maintained on

the License Type Maintenance window (LP> Maintenance> License Type

Maintenance).

l You can also click the View Schedule icon to view the renewal schedule for

the selected license type.

l The Application Number field will automatically populate with the next available

application number when the application is saved.

l Enter a License Number if you are creating a new license.

l The License Number field will not be active if you selected Auto Numbering

when setting up the LP Module.

l Enter the company name in the Doing Business As field.

l Enter a Business Number or click the field label to choose one from a list. Busi-

nesses are created and maintained on the Business Maintenance window (BT>

Maintenance> Business).

l The Customer Number, Customer Name, Lot Number and Service Address

fields will automatically populate with the information associated with the selected

business number.

l If the Customer Number does not automatically populate, or if you are cre-

ating a license or application for an individual rather than a business, you

must click the field label and select a customer from the list. This is a required

field.

l Click the License Status field label to specify a license status for the license.

l The License Status field will automatically populate with the status specified

on the License Type selected above.
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l The license status will automatically update as the license progresses

through events specified on the License Type Maintenance window. For

example, if the selected license type has a Status On Application of

"APP" and a Status On New License of "NEW", the License Status field

will display "APP" if it is created as an application and "NEW" if it is cre-

ated as a new license or created from the application.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status Maintenance).

l Select an Application Date from the drop-down menu. This field will default to

today's date but can be edited.

l The Issue Date is the date that the license is physically delivered to the business or

customer. This date does not have to be the same as the Start Date.

l The Issue Date field will automatically update to today's date when generating

a license from an existing application.

l The Start Date field will automatically populate with the start date specified on the

License Type selected above. This is the date that the license is considered active

and the license term begins.

l
If the Start Date is updated, the Recalculate icon can be used to recal-

culate fee penalty units based on the new start date.

l The Duration, Duration Units, and Expiration Date fields will populate with the

information attached to the selected License Type.

l The Expiration Date is tied to the Start Date, and will reflect a time period

established by the values in the Duration and Duration Units fields.

l Check the Print license on receipt save toggle to automatically print the license

when the receipt is saved.
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l In order for this toggle to take effect, the current operator must be set up to

print the receipt on save. This setting is enabled on the Operator Maintenance

window (CR> Maintenance> Operator> Automatically Print Receipt on

Save toggle).

4     Complete the category-specific section of the license. 

l The category-specify section of the license will change based on the selection in the

Category drop-down menu.

l Add business types to the license or application if Business is selected.

l
Click the Create icon drop-down menu and select New Business Type to

attach a business type to the license. This will open the Business Types selec-

tion window.

l The Business Types selection window will display all business types

that have been created in the LP module. Business types are created

on the Business Type Maintenance window (LP> Maintenance> Busi-

ness Types).

l
Highlight a business type and click the Confirm icon to attach a busi-

ness type to the license.

l If Pet or Vehicle is selected from the Category drop-down menu, enter the pet or

vehicle information in the available fields.

5     Complete the Fees section. 
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l The Fees section will display any fees attached to the license or application.

l Any fees attached to the License Type selected above will be displayed in the

data grid.

l
Click the Create icon drop-down menu and select New Fee to add a fee to the

license. This will open the Fee Selection window.

l
Select a fee and click the Confirm icon to add the fee to the license.

l Edit the Fee Units field if desired. If the License Type selected has a fee code

attached that uses units for rate calculations, the appropriate Unit Type will be

displayed.

l Fees are created and maintained on the Fee Maintenance window (LP> Main-

tenance> Fee).

6     Complete the Forms section. 

l The Forms section will display any forms attached to the license.

l
Click the Create icon drop-down menu and select New Form to attach a form let-

ter to the license.

l Forms are created and maintained on the Forms Maintenance window (LP> Main-

tenance> Forms).

l Check the Print toggle for any forms you would like to print immediately. The

forms will be sent to the specified printer after payment is received and the
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receipt is saved.

l The print process for LP forms is designed to bypass all existing print

jobs in the system. This will prevent any excessive delays between the

license creation and license print steps as a result of existing print jobs.

Because of this, the print forms process will not display in the Jobs

Viewer.

l The printed forms will also be saved as attachments on the license record.

l
Click the Void icon to void a license invoice after it has been created. This will

remove any information associated with the license or application from the system.

l
Click the Save icon after all of the license details have been entered. This will

return you to the Cash Entry window.

7     Receive payment on the license. 

l The customer and account information associated with the new license or applic-

ation should populate the Cash Entry window.

l The Amount Due will display the balance on each account included on the receipt.

l The Amount to Pay column will populate with the balance of each customer

account on the receipt.

l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.
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l
Enter a payment amount in the Payments section and click the Save icon to

save the payment. This will also print the license forms specified in the previous

step.

8     Commit the cash receipts batch. 

l If the License Type used to create the new license or application is set up with mul-

tiple License Statuses, committing the receipt will automatically update the License

Status. For example, if the selected License Type is set up with OutPay (out-

standing payment due) and PayFull (paid in full) statuses, when the license is cre-

ated it will be in OutPay status. Once the license fees are paid in full and the CR

batch is committed, the license status would switch to PayFull (paid in full).
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CR> Cash Receipts> Enter Receipts

KVS Tax Interface in CR

Summary

The KVS Tax Interface allows Springbrook to communicate directly with your KVS Tax Sys-

tem. The KVS Tax Search window allows users to search KVS tax data, select entire tax

bills or individual tax bill installments to be paid, and then import that data into the Cash

Receipts module. Once a receipt is generated, Springbrook will automatically update the

related accounts in the KVS Tax System.

This interface will only be enabled if the Enable KVS tax interface toggle is checked on the

CR Setup window.

Step by Step

1     Open the Cash Entry window. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).
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l The Cash Entry window can be opened from two separate palette options: Enter

Receipts or Cash Entry.

l The Enter Receipts item on the Cash Receipts palette will display all of the

receipts that have been entered in a batch. This allows you to open and

modify all of the receipts in the batch.

l
Click the Show Batch Totals icon to open an informational window that will

display Cash, Check, Other, Change and Batch totals for the active receipts

included in the batch. Totals will not include voided receipts.

l The Cash Entry menu item will open the Cash Entry window but only allow

users to view the receipt being generated.

l Menu security (SS> Security> Menu Security) can be set up on the Cash

Receipts palette to disable one of the palette options.

l
Click the Delete icon or press DELETE to void a receipt that is included in the

batch.

l
Highlight a receipt and click the Modify icon or press ENTER to edit an existing

receipt.

l
Click the Create icon or press INSERT to create a new receipt for the batch.

This will open the Cash Entry window.

2     Open the KVS Tax Search window. 
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l
Click the Interfaces icon drop-down menu and select KVS Tax. This will open

the KVS Tax Search window.

3     Search for the desired KVS tax data. 

l The KVS Tax Search window is used to search though KVS tax data and import the

selected tax data into Cash Receipts for processing.

l Enter the desired tax data in the Search Criteria section.

l The Penalty Date field is used to calculate bill amounts once the tax data is

imported into Cash Receipts. This is a required field.

l Data must be entered in at least one other search field in order to search

through the KVS tax data.

l
Click the Refresh icon to display the search results in the Bills section below.

4     Select the KVS tax bills to be processed in Cash Receipts. 

l The data grid in the Bills section will display the search results in a two-tiered data

structure. The parent lines are the KVS tax bills and the child lines are the related

installment payments. The details associated with the selected tax bill will be dis-

played in the data fields to the left.
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l Check the Pay toggle next to each bill or installment you would like to pay.

l Checking the Pay toggle next to a parent bill will import all the child install-

ments into Cash Receipts for processing.

l When checking the Pay toggle next to individual installments, they must be

paid in sequence. For example, if installment 5 is unpaid, you will not be able

to select only installment 6 for processing. Multiple installments can be pro-

cessed, but they must be in order.

l The Payment Amount field will display the total amount of installment pay-

ments that will be imported into Enter Receipts window for processing.

l This field will automatically populate with the total amount of all the

selected bills and installments. The KVS Tax interface does not cur-

rently support partial payments.

l
Click the Save icon to import the selected installments. This will disable the KVS

Tax Search window and display a progress bar in the lower left. Once Springbrook

is finished communicating with the KVS Tax system, The KVS Tax Search window

will close and the tax data will be displayed in the Enter Receipts window.

5     Process the tax payments. 

l The Enter Receipts window will now display the KVS tax bills and installments that

will be included in the receipt.

l The Account/Category tab will display the total Amount Due based on the

bills and installments selected on the previous screen while the Amount to
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Pay column will display the Payment Amount specified on the previous

screen.

l The Detail tab will display the individual bills and installments that will be

included in the receipt.

l Use the Payments section to enter the payment amount, payment method and any

reference notes you would like to add.

l
Click the Save icon to save the receipt.

6     Commit the Cash Receipts batch. 

KVS TAX INTERFACE IN CR 87



CR> Cash Receipts> Enter Receipts

Create an SA Pay Down

Summary

The Cash Receipts module can be used to receive full pay downs and partial payments on

SA Assessments.

Step by Step

1     Open the Cash Entry window. 

l Open a CR Cash Receipts batch or create a new batch using the New Batch win-

dow (CR> Cash Receipts> Select New from the batch drop-down menu).

l The Cash Entry window can be opened from two separate palette options: Enter

Receipts or Cash Entry.

l The Enter Receipts item on the Cash Receipts palette will display all of the

receipts that have been entered in a batch. This allows you to open and

modify all of the receipts in the batch.
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l
Click the Show Batch Totals icon to open an informational window that will

display Cash, Check, Other, Change and Batch totals for the active receipts

included in the batch. Totals will not include voided receipts.

l The Cash Entry menu item will open the Cash Entry window but only allow

users to view the receipt being generated.

l Menu security (SS> Security> Menu Security) can be set up on the Cash

Receipts palette to disable one of the palette options.

l
Click the Delete icon or press DELETE to void a receipt that is included in the

batch.

l
Highlight a receipt and click the Modify icon or press ENTER to edit an existing

receipt.

l
Click the Create icon or press INSERT to create a new receipt for the batch.

This will open the Cash Entry window.

2     Create an SA pay down. 

l The Cash Entry window uses two search filtering tabs.

l You can enter the Customer Number on the Customer tab to populate the

Account/Category section below with all of the Springbrook accounts asso-

ciated with that customer. You can also click the Customer Number field label

to open the Customer Selection window. From here you can select the cus-

tomer and the SA account you would like to add to the receipt.
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l Alternatively, you can enter an SA Assessment Number on the Search tab

or click the field label to select the desired SA account from a list.

l An assessment that is included in another uncommitted batch that could

affect principal due and interest due totals cannot be included in a Cash

Receipts batch.

l Once the desired SA assessment is displayed in the Account/Category grid below,

highlight the account and click the SA Pay Down Assessment icon .

l This will populate the Amount Due and the Amount to Pay fields with the full

Payoff Amount for the assessment (SA> Maintenance> Assessment> Gen-

eral tab> Payoff Amount field).

l The Detail tab will populate with line items representing total principal due and

total interest due. When an SA assessment is paid off, two invoices are gen-

erated.

l The first invoice is applied to any unpaid interest due. The interest due

amount includes any unbilled interest due as of the receipt date, cal-

culated from the assessment's Last Interest Date (SA> Maintenance>

Assessment> General tab> Last Interest Date field).

l The second invoice is applied to any remaining principal. The principal

due amount includes all unbilled principal on the assessment minus any

credits on the account.

l Update the Amount to Pay field with the amount being paid on the receipt.

l This will update the Details tab as well. Payments are always applied to

interest first with any remaining amount applied to the principal.

l If the amount being paid on the assessment exceeds the amount due for the

billing period, the future bill amounts can be recalculated across the
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remaining term of the assessment. This recalculation is optional and is made

on the Change Assessment window (SA> Utilities> Change Assessment).

l Click the Amount field in the Payments section above and the Amount to Pay

entered below will automatically populate. Select a Pay Method and enter an

optional Reference number.

l If you are using a pay method that has an associated cash override account,

no other pay methods can be used on the receipt.

l
Click the Save icon to save the new receipt and return to the Enter Receipts win-

dow. The newly created receipt should now be displayed.

l
Repeat these steps to process additional SA payments or click the Exit icon to

continue.

3     Commit the cash receipts batch. 
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CR> Cash Receipts> Quick Type Entry
Window

Quick Type Entry Window

Summary

The Quick Type Entry window is used to add a type code on a receipt, but is mainly

designed to reduce data entry when entering multiple type codes on a single receipt. The

Quick Type Entry window is opened by selecting Quick Enter Type from the Create drop-

down menu at the top of the Cash Entry window when the Detail tab is open. (The function

of the Create icon changes depending on which tab is open in the window, so the Quick

Enter Type option will only display when the Detail tab is open.)

This is an optional feature because you can also add type codes to a receipt using the

standard method of selecting the type code in the Type Code Selection window.

Step by Step

1     Open the Cash Entry window. 
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l The Cash Entry window is used to enter payments.

l There are two ways to open the Cash Entry window: (CR> Cash Receipts> Enter

Receipts> INSERT) or (CR> Cash Receipts> Cash Entry). Some organizations

restrict access to the Enter Receipts menu option because it displays all receipts in

the batch. The Cash Entry menu option only displays the receipt that is being cre-

ated.

2     Attach a customer to the receipt. 

l Select a customer and customer account if you would like that information to display

on the receipt. The payment of the type code will not affect the balance of the cus-

tomer account included on the receipt unless the type code is creating a UB deposit.

l You are not required to enter a customer number or customer account when

creating a receipt using a type code because the receipt will not affect the

customer account balance. The advantage of including a customer number on

the receipt is that the customer information can be included on the slip and

will be included in Cash Receipts module reports.

l The customer information will only display on the receipt if there are cus-

tomer information fields attached to the slip that will print when the

receipt is printed.

l Slips are created in UB> Maintenance> Slip.

l Click the Customer Number field label to select a customer from a list. This

will open the Customer Accounts window.
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l If you select a customer number, all accounts attached to that customer

will populate on the receipt.

l Click the Expand button next to a customer record to view the customer

accounts attached to the customer record. Select a customer account to

only populate that account on the receipt. Remember, the balance of

the selected customer account will not be affected by the payment of a

type code. Attaching a customer account to a receipt allows you to pay

the balance of a customer account at the same time as entering pay-

ment on a type code, and adds the customer information to the receipt.

l The fields in the Customer Information section on the Cash Entry win-

dow will populate with the customer record information. If customer

accounts were included on the receipt, each account will create a sep-

arate line item on the Account/Category tab of the Cash Entry window.

l Select the customer account balances to pay, or remove them from the receipt on

the Account/Category tab.

l All of the customer accounts attached to the receipt will display on the Accoun-

t/Category tab.

l Press INSERT to add another customer account to the receipt. This will

open the Customer Accounts window again.

l Highlight a customer account on the Account/Category tab and press

DELETE to remove the account from the receipt. This will not delete the

customer account or the amount due, it will only remove the account

from the receipt.
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l If the customer wants to make a partial payment on a customer account, enter

the payment amount in the Amount to Pay column. You can also adjust the

payment amount on the Detail tab.

3     Add a type code to the receipt. 

l Click on the Detail tab of the Cash Entry window.

l
Select Quick Enter Type from the Create icon drop-down menu. This option will

only display in the Create icon drop-down menu when the Detail tab is open.

l This will open the Quick Type Entry window.

l Click the Type Code field label to select a type code from a list.

l The advantage of the Quick Type Entry window is you can enter the type code

in the Type Code field instead of having to select the type code from a list.

For example, if you would like to generate a receipt on a type code titled DEP,

enter DEP in the Type Code field and the type code information will populate

in the window.

l The Account drop-down menu is used to select the customer account on the

receipt that will be charged the type code. This field only applies to deposit type

codes and is only enabled when a UB module deposit type code is selected in the

Type Code field. All of the UB customer accounts attached to the receipt will dis-

play in the drop-down menu. Any UB module customer accounts attached to the

receipt on the Account/Category tab of the Cash Entry window will display in the

Account drop-down menu.
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l The Account field only applies to type codes set up as UB module deposits

because those are the only type code transactions that are posted to a cus-

tomer account. If a type code does not create a deposit on a UB account, the

type code transaction will not create a history line item on a customer

account.

l The Description field is used to enter the description of the type code. This field will

populate with the description of the type code (CR> Maintenance> Type Code>

Description field).

l The Amount field will populate with the amount of the type code transaction.

l The Debit Account and Credit Account fields will display the GL accounts used in

the journal entry created by the receipt. Click the field labels to select a GL account

from a list.

l The Task Code fields will populate if a Project Management module task code is

attached to the type code. These fields will only be enabled if you use the Project

Management module.

l
Press ENTER or click the Save icon when complete. This will add the type code

to the receipt and the Quick Type Entry window will stay open. The Quick Type

Entry window stays open until you either press ESCAPE or click the Exit icon .

This reduces data entry if you are entering more than one type code on the receipt.

4     Receive payment on the receipt. 
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l The Payments section on the Cash Entry window is used to enter the payments on

the receipt.

l Enter the amount of payment in the Amount column in the Payments section.

By default, the field will populate with the total amount due on the receipt

when the cursor is placed in the field.

l If a customer wants to pay using multiple pay methods (cash and check

for example), you can create multiple payment line items in the Pay-

ments section.

l Select a Pay Method from the drop-down menu.

l Pay methods are created and maintained in CR> Maintenance> Pay

Method.

l If there are slips attached to the pay method they will print when the

receipt is saved.

l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.

l Verify the receipt date is correct.

l The receipt date is entered in the Date field in the Receipt Information sec-

tion. The receipt date is used on many of the Cash Receipts module reports.

l
Click the Save icon when complete to save the receipt.

l There are three ways to determine which slips will print out when a receipt is gen-

erated in the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle on the Operator Main-

tenance window (CR> Maintenance> Operator) to print all slips that are set up

as default receipts in the Maintain Slips window (CR> Maintenance> Slip
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Maintenance). If there are no default slips set up, no slips will print.

l If the Automatically print receipt on save toggle is not checked on

the Operator Maintenance window, the default slips will not print when

receipts are saved in the Cash Entry window.

l Slips attached to a payment method will print when that payment method is

used on the receipt. Slips are attached to payment methods in the Payment

Method Maintenance window (CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to the check payment

type so that the endorsement will print when the check payment type is

used on a receipt.

l Slips attached to a type code will print when that type code is added to a

receipt. Slips are attached to type codes in the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

l All three of these methods can be used in conjunction, but the slips that are

set up as default slips in the Maintain Slips window will always print before the

slips that are attached to payment method or type code.
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Cash Entry Window

Adjust a Committed Receipt using a Zero Amount
Type Code

Summary

If an incorrect CR type code has been entered on a receipt and the receipt has already

been committed, you can create a zero dollar receipt to adjust the receipt amount to the cor-

rect type code. This kind of adjustment is necessary if the general ledger accounts

attached to the type code on the original receipt are different than the general ledger

accounts attached to the type code you would like to adjust. Type code transaction inform-

ation is not attached to customer accounts, so adjustments to type codes only affect the

general ledger accounts that receipts are posted to. You can also create a journal entry in

the GL module instead of creating a type code adjustment to adjust the GL accounts to the

correct amount.

l You can view the GL accounts attached to a type code in CR> Maintenance> Type Code>

Debit Account and Credit Account fields.

The journal entry created by this adjustment is as follows:

Original receipt
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GL Account Description Debit Credit

Debit GL Account attached to type code XXX

Credit GL Account attached to type code XXX

Adjustment

Part 1: This reverses the original receipt.

GL Account Description Debit Credit

Debit GL Account attached to original type code XXX 

Credit GL Account attached to original type code XXX 

Part 2: This creates the receipt amount on the correct type code.

GL Account Description Debit Credit

Debit GL Account attached to new type code XXX

Credit GL Account attached to new type code XXX

In order to create a zero dollar receipt, you must have the Allow Zero Dollar Receipts
toggle checked on the Cash Receipts module Setup window (CR> Utilities> Setup).

Step by Step
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1     Open the Cash Entry window. 

l There are two ways to open the Cash Entry window: (CR> Cash Receipts> Enter

Receipts> INSERT) or (CR> Cash Receipts> Cash Entry).

l It is not necessary to enter a customer number on the zero dollar receipt. The type

code information is not attached to a customer account, so the adjustment will not

modify a customer account. The only advantage of attaching a customer number to

the adjustment is to have the customer information on the receipt.

2     Reverse the original receipt. 

l Open the Detail tab on the Cash Entry window.

l Press INSERT. This will open the Type Code Selection window.

l Highlight the type code used on the original receipt and click the Confirm icon

. This will close the Type Code Selection window and return you to the

Cash Entry window with the selected type code populated on the receipt.

l Selecting a type code will create a line item on the detail tab and populate it with the

type code information.

l Verify the amount in the Amount to Pay field is the same amount as the ori-

ginal receipt.

l If the amount is different, change the amount in the Amount to Pay field

so that it equals the amount of the original receipt.
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l Enter a (-) sign in front of the amount in the Amount to Pay field. This will cre-

ate a negative line item on the receipt.

3     Move the receipt amount to the correct type code. 

l Press INSERT while the Detail tab is still open. This will open the Type Code Selec-

tion window.

l Highlight the type code that should have been used on the receipt and click

the Confirm icon . This will close the Type Code Selection window and

return you to the Cash Entry window with the selected type code populated on

the Detail tab below the negative line item.

l Modify the amount in the Amount to Pay column until the Total Due field in the

Receipt Information section is zero.

l Enter a description of the transaction in the Description field of the receipt line item

if you would like the adjustment description to display on the detailed version of the

Cash Receipts Proof List (CR> Cash Receipts> Proof List).

l
Click the Save icon when complete to save the receipt.

4     Commit the receipt. 
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l Print a Proof List from the Proof List window (CR> Cash Receipts> Proof List).

l Print the Proof List in detail format so that the offsetting receipt line items will

display on the report. If you print the Proof List in summary format, the report

will only display the zero dollar amount on the receipt.

l The detailed format will also display any line item description entered in

the Description field on the Detail tab of the Cash Entry window.

l Since the receipt line items result in a zero dollar receipt, the line items will not

be included in the receipt totals at the bottom of the report.

l Print a GL Distribution Report from the GL Distribution window (CR> Cash

Receipts> GL Distribution).

l Print the GL Distribution report in detailed format if you would like to include

the receipt number on the report. This can be helpful if there is more than one

receipt in the Cash Receipts batch.

l The process will create two separate transactions:

GL Account Description Debit Credit

Debit GL Account attached to original type code XXX

Credit GL Account attached to original type code XXX

GL Account Description Debit Credit

Debit GL Account attached to new type code XXX

Credit GL Account attached to new type code XXX
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l The GL Distribution report will only display net amounts. If the original type

code and adjustment type code share a GL account, the journal entry line

items associated with those shared accounts will not display on the report

since they result in a wash. For example, if the debit GL account is the same

for both type codes the journal entry line items created by those GL accounts

will not display on the report since they cancel each other out.

l Commit the Cash Receipts batch in the Commit window (CR> Cash Receipts> Com-

mit).
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Cash Entry Window

Create a Receipt for a UB Customer

Summary

The Cash Entry window is used to enter payments on customer accounts, including pay-

ments on Utility Billing module accounts. When a payment is made on a UB module

account in a Cash Receipts batch, the receipt date on the payment will be used as the trans-

action date of the payment in the Utility Billing module.

When you enter a payment on a UB customer account in a Cash Receipts batch, there are

two additional reports that need to be generated before the batch can be committed: UB

Proof List and UB GL Distribution.

The UB Proof List Report is similar to the Cash Receipts Proof List, but it will total the

receipt line items by service rather than payment type. The UB Proof List will only display

receipt line items on UB accounts. Receipt line items on non-UB accounts, Cash Receipts

module type codes or voided receipts will not display on the report. If the UB module is set

up to automatically redistribute credit balances, the redistribution transactions will display

on the report.

The UB GL Distribution Report is similar to the Cash Receipts GL Distribution Report, but it

will display the service rates and fee codes that are on the receipt.
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The Cash Entry window can be used to create deposits on UB module accounts.

Step by Step

1     Create a Cash Receipts batch. 

l Select the New Billing palette in CR> Cash Receipts. This will expand the Cash

Receipts palette and display the steps of the Cash Receipts process.

l Select New from the Cash Receipts batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Cash Receipts process, you can create a new

batch without affecting the transactions in the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the receipt or journal entry date of the transactions in the batch.

l The receipt date is entered when each receipt is generated and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report (CR> Cash Receipts>

GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.
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l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Open the Cash Entry window. 

l There are two ways to open the Cash Entry window: (CR> Cash Receipts> Enter

Receipts> INSERT) or (CR> Cash Receipts> Cash Entry). The way you access the

Cash Entry window depends on the security setup in the Cash Receipts module.

3     Select the customer and customer accounts to pay. 

l The Customer Information section is used to select the customer that is paying the

receipt.

l If a customer is paying a balance on another customer’s account, you do not

have to enter customer information into this section. You can use the Accoun-

t/Category tab to add the customer account that is being paid onto the receipt.

l Add a single customer's accounts to the receipt by clicking on the Customer Num-

ber field label to select the UB customer that is paying. This will open the Customer

Accounts window.

l The Customer Accounts window will display all customer and customer

accounts created in the application.
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l Enter information into the Search Criteria section and click the Refresh icon

to filter the customers that display in the window.

l Click the Expand button next to a customer record to display all of the cus-

tomer accounts attached to the customer.

l Select a customer record to include all of the accounts attached to the cus-

tomer or select a customer and hold down CTRL to select which accounts to

include on the receipt.

l You can include all of the accounts on the receipt in the Customer

Accounts window and then remove specific accounts using the

Accounts tab on the Cash Entry window.

l An alert window will open if there is a receipt alert on the customer account.

l Receipt alerts can be added to UB customer accounts using an adjust-

ment type code (UB> Maintenance> Adjustment Type> Receipt Alert

toggle). If the adjustment type code has been used to create a trans-

action on a customer account (for example, past due penalties), an alert

window will display when the customer account is selected in the Cash

Entry window.

l The alert window will display the transactions on the customer account

that create the alert. For example, if the customer account was

assessed past due penalties, the penalty transaction will display in the

window.

l Add multiple accounts from multiple customers to the receipt by clicking the Create
icon drop-down menu and selecting Add UB Accounts with Amount. This will

open the Account Selection window.
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l The Account Selection window will display all customer and customer

accounts created in the application.

l Enter information into the Search Criteria section and click the Refresh icon

to filter the customers and accounts that display in the window.

l
Highlight an account and click the Modify icon to open the UB Account Main-

tenance window for the selected account.

l
Highlight an account and click the Add Account icon to add the account to the

Selected Accounts section to the right.

l Multiple accounts from multiple customers can be added to a single

receipt. You can use the CTRL or SHIFT keys to select multiple

accounts before adding them to the Selected Accounts section. If an

account is added once, an error message will appear informing you that

the duplicate account will not be added to the receipt but all the other

accounts will proceed as expected.

l Accounts that were mistakenly added to this section can be removed
with the Remove Account icon .

l
Click the Confirm icon to add the selected accounts to the receipt.

l You can repeat this filtering and selection process using Add

UB Account with Amount without overwriting the accounts previously

added to the receipt.

l After a customer account has been selected the Accounts/Category tab will display

all of the customer accounts that have been included on the receipt.

l Select the customer account balances to pay or remove them from the receipt.
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l The customer accounts selected in the Customer Accounts window will dis-

play on the Accounts/Category tab. If a single customer was selected, all

accounts attached to the customer will display in the Cash Entry window.

l If the customer owes a balance on any of the accounts, the Total Due field in

the Receipt Information section will update with the balance of all of the

accounts.

l If the customer is making a partial payment on an account, that will be

set up on the Detail tab.

l If the customer does not want to pay the balance on one of the accounts, high-

light the account and press DELETE. This will remove the account from the

receipt and update the Total Due field with the new balance.

l If the customer is paying another customer’s bill, select Add New Account

from the Create icon drop-down menu. This will open the Customer

Accounts window again. Select the customer or customer accounts that

should be included on the receipt and press ENTER. This will add the selec-

ted customer or customer accounts to the receipt.

l Just like when the customer was selected in the Customer Information

section, select a customer to include all customer accounts on the

receipt or select a customer and customer accounts.

l If the customer is making on overpayment on an account, enter the total amount of

the payment in the Amount to Pay field.

l The overpayment will be applied to the services attached to the customer

account based on the overpayment percentage setup of the services and how

the UB module is set up.
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l If Last Bill is selected in the Overpayment Distribution drop-down menu on

the UB setup (UB> Utilities> Setup> Payment tab), the overpayment will be

applied to the services on the account based on the distribution between the

services on previous billings.

l If Fixed Percentage is selected in the Overpayment Distribution drop-down

menu on the UB setup, the overpayment will be applied to the services on the

customer account based on the overpayment percentages setup on the ser-

vices (UB> Maintenance> Service> Overpayment Percentage field).

4     Select the services and amount to pay or enter a deposit on the customer account. 

l The Detail tab displays the services attached to the accounts on the receipt and the

balance of each service.

l The Amount to Pay column displays the amount that will be paid on each service.

By default, the Amount to Pay field will equal the amount due on the service.

l Modify the amount in the Amount to Pay field to enter a partial payment on a ser-

vice. The Total Due field in the Receipt Information section will update after the

amount has been modified.

l Press INSERT to enter a customer deposit. This will open the Type Code Selection

window.

l Select a CR module type code that is set up as a UB module deposit and

press ENTER to add the deposit to the receipt.
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l In order to create the cash deposit, the CR module type code must have the

UB Deposit Type toggle checked on the Type Code Maintenance window

(CR> Maintenance> Type Code) and there must be a UB module fee code set

up as a deposit fee code with the same title as the type code. For example, if

the type code is titled “DEP”, then the UB fee code must also be titled “DEP.”

5     Enter the payment. 

l The Payments section is used to enter the payments on the receipt.

l Enter the amount of payment in the Amount column in the Payments section.

By default, the field will populate with the total amount due on the receipt

when the cursor is placed in the field.

l If a customer wants to pay using multiple pay methods (cash and check

for example), you can create multiple payment line items in the Pay-

ments section.

l Select a Pay Method from the drop-down menu.

l Pay methods are created and maintained in CR> Maintenance> Pay

Method.

l If there are slips attached to the pay method they will print when the

receipt is saved.

l If you are using a pay method that has an associated cash override

account, no other pay methods can be used on the receipt.
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l If you are processing a counter receipt through a credit card terminal, see the

Credit Card Terminal Payments topic for details.

l Highlight a payment line item and press DELETE if you would like to delete the pay-

ment line item.

l Verify the receipt date is correct.

l The receipt date is entered in the Date field in the Receipt Information sec-

tion. The receipt date is used as the transaction date on the payment and is

also used on many of the Cash Receipts module reports.

l
Click the Save icon when complete to save the receipt.

l There are three ways to determine which slips will print out when a receipt is gen-

erated in the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle on the Operator Main-

tenance window (CR> Maintenance> Operator) to print all slips that are set up

as default receipts in the Maintain Slips window (CR> Maintenance> Slip

Maintenance). If there are no default slips set up, no slips will print.

l If the Automatically print receipt on save toggle is not checked on

the Operator Maintenance window, the default slips will not print when

receipts are saved in the Cash Entry window.

l Slips attached to a payment method will print when that payment method is

used on the receipt. Slips are attached to payment methods in the Payment

Method Maintenance window (CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to a check payment

type so that the endorsement will print when the check payment type is

used on a receipt.
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l Slips attached to a type code will print when that type code is added to a

receipt. Slips are attached to type codes in the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

l All three of these methods can be used in conjunction, but the slips that are

set up as default slips in the Maintain Slips window will always print before the

slips that are attached to payment method or type code.

l If the account selected is in delete status, a warning message will be displayed

when you attempt to save the receipt. This warning message is informational only

and will not prevent you from processing the receipt.

6     Commit the batch. 
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Cash Entry Window

UB Cash Deposits

Summary

A cash deposit is a deposit created at the time cash is received. Creating a cash deposit

does not require that the deposit was charged to the customer account when the account

was created using the New Account Wizard.

If a deposit is created from the New Account Wizard, the wizard will create a Billing trans-

action in UB Adjustments and Fees. When the Billing transaction is paid, a Payment trans-

action will be created to pay the Billing line and a Deposit transaction will be created to

record the deposit amount on the customer account. A Cash Deposit is different because it

records the Billing, Payment and Deposit transactions in one step.

Step by Step

1     Create a cash deposit using the Cash Entry window. 
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l Open or create a Cash Receipts batch in CR> Cash Receipts.

l Open the Cash Entry window (CR> Cash Receipts> Enter Receipts, or CR> Cash

Receipts> Cash Entry).

l Select the customer you would like to enter the deposit on in the Customer Num-

ber field.

l Click the Customer Number field label to select a customer from a list.

l The selected customer must have a Utility Billing module account.

l Open the Detail tab of the Cash Entry window.

l Press INSERT to add a type code to the receipt. This will open the Type Code Selec-

tion window to select a Cash Receipts module type code.

l The Cash Receipts module type code must have the same code as a deposit

fee code in the UB module.

l The Amount Due column will populate with the amount attached to the Cash

Receipts type code (CR> Maintenance> Type Code> Open the deposit type code>

Amount field).

l Enter a payment and save the receipt.

2     Print a UB Proof List Report. 

l Print a UB Proof List Report (CR> Cash Receipts> UB Proof List).

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

UB CASH DEPOSITS 116



can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The UB Proof List Report will display the deposit as a Cash Deposit transaction

type. The Proof List Report will also display the service being charged on the

deposit. The deposit fee code (UB> Maintenance> Fee Code> Select a fee code>

Service to Charge field) in the UB module determines the service that will be billed

the deposit amount.

l The total amount of cash deposits in the batch will display in the Cash Deposits

this batch field at the bottom of the UB Proof List Report.

3     Print the UB GL Distribution Report. 

l Generate the UB GL Distribution window (CR> Cash Receipts> UB GL Distribution).
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The cash deposit will create the following journal entry:

Description of GL account Debit Credit

Cash account on deposit fee code XXX

Revenue account on deposit fee code XXX

l If the general ledger accounts used in the journal entry are not correct you can

change the GL accounts attached to the deposit fee code using the Fee Code Main-

tenance window (UB> Maintenance> Fee Code). Changing the GL accounts on the

deposit fee code will update the GL accounts used in the journal entry created by

the UB GL Distribution Report.
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4     Commit the Cash Receipts batch. 

l Commit the Cash Receipts batch if the journal entry to create the deposit is correct.

l Once you commit the payment, the deposit will display on the History tab of the

Account Master Maintenance window (UB> Maintenance> Account> History>

Deposit History).
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CR> Cash Receipts> Import UB Receipts

Import Lockbox Transactions

Summary

The Import Cash Receipts process allows you to import transactions from a lock box loc-

ation and update customer accounts with the payments. The lockbox transactions are

imported into the application from a file and the format of that file will vary depending on the

bank that receives the payments. In order to use this process, your bank must send you a

list of lockbox transactions in a file format that can be imported.

Follow this process to import the file containing the lockbox information. If you do not have

the file containing the transactions to import, you will have to obtain the file before running

this process.

Step by Step

1     Create a new CR Cash Receipts batch in CR> Cash Receipts. 

l Select New from the CR Cash Receipts batch number drop-down menu to create a

new batch. This will open the New Batch window.
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l If there are open batches in the Cash Receipts process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the imported transactions is either entered during the

Import step or is pulled from the imported transactions.

l The fiscal period the imported transactions are posted to is determined by the

Journal Entry Date entered when creating the GL Distribution Report in CR>

Cash Receipts> GL Distribution.

l You can delete batches by selecting a batch and pressing DELETE.

2     Import cash receipts. 

l Select Import UB Receipts from the Cash Receipts palette. This will open the Import

window.

l You can run the Import UB Receipts step as many times as you would like. For

example, if you have multiple import files, you can run the Import UB Receipts step

multiple times in the same batch. The transactions in each import file will be added

to the Cash Receipts batch. This also means that if you accidentally import the

same file twice, the payments will be added to the batch twice.

l Input a payment date in the Payment Date field. This field will default to the current

date.
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l The date entered in this field will be used as the transaction date of the trans-

actions being imported unless you check the Use Record Date toggle.

l Select the format of the file you would like to import from the Format drop-down

menu.

l Select the payment method of the imported transactions from the Currency Type

drop-down menu.

The payment type selected in this field will be applied to all of the transactions in the

batch.

l The payment types are set up in the Pay Method Maintenance window (CR>

Maintenance> Pay Method).

l Click the File Location field to select the file you received from the bank or third

party. This is the file that contains the transactions you would like to import.

l Check the Use Record Date toggle if you would like the transaction date on the

transactions to be pulled from the import file rather than the Transaction Date field.

l
Click the Confirm icon to import the transactions from the file into the batch.

l The import process is run immediately, so the job cannot be scheduled for a

later time.

3     View the imported lockbox transactions in the Enter Receipts window. 

l This is an optional step and does not apply to users that access the Cash Entry win-

dow using the Cash Entry option on the Cash Entry palette.
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l The Enter Receipts window will display all of the lockbox transactions that have

been imported into the Cash Receipts batch. The Enter Receipts window is opened

using the Enter Receipts window. If the Enter Receipts option has been disabled on

the Cash Receipts palette, you cannot open the Enter Receipts window.

l Select Enter Receipts from the Cash Receipts palette to open the Enter Receipts

window.

l All of the lockbox transactions imported into the batch will display in the window.

Highlight a transaction and press ENTER to open the Cash Entry window and

modify the payment.

l Press ENTER to save the changes.

4     Print a Proof List. 

l The Proof List will list all of the receipts in the batch totaled by payment type.

l Open the Proof List window (CR> Cash Receipts> Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l Select Detail to display a separate line item for detail line item on the receipt.

The detailed version of the report shows the receipt number, whether or not

the receipt was voided, customer number, date, customer name, cash receipt

type, description, receipt amount and the amounts for cash, check, other,

change, net cash and total.  Each receipt is totaled and the report has a grand

total.
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l Select Summary to display a single summary line item for each receipt.  The

report shows the receipt number, whether or not the receipt was voided, cus-

tomer number, date, customer name and the amounts for cash, check, other,

change, net cash and total.  There is a grand total for the report.

l Select how the report should be sorted in the Sort By drop-down menu.

l Select Customer Number if you would like to sort the receipts that display on

the report by the customer number attached to the receipt.

l Select Receipt Number if you would like to sort the receipts that display on the

report by receipt number.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the UB Proof List. 
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l You will be required to print the UB Proof List because there are UB module pay-

ments in the Cash Receipts batch. The UB Proof List Report is similar to the Cash

Receipts Proof List, but it will display the payment made to each UB module service.

l Select UB Proof List from the Cash Receipts palette. There are no filter or sort

options on this report.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The UB Proof List will display the payment, all 20 UB services and the portion of the

payment that is paid to each service. If a UB deposit is being created in the batch,

the service attached to the deposit type fee code will be billed a negative amount.

l There will also be an amount in the Cash Deposits this batch total field at the

bottom of the report.
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6     Print a GL Distribution List. 

l Select Distribution List on the Cash Receipts palette. This will open the Receipt

Distribution Report window.

l The Journal Entry field will determine the fiscal period and fiscal year of the journal

entry created by the batch.

l The journal entry date will default to the current date.

l The Fiscal Period and Fiscal Year fields are not enabled and will populate based

on the date entered in the Journal Entry field.

l Select the level of detail you would like to include on the report in the Report Type

drop-down menu.

l The Detail report will display the fund, general ledger account, general ledger

account description, receipt number, line item description, debits and credits.

The report will also group and total the report by fund, and display report

totals of the debit and credit columns.

l The line item description of a receipt can be viewed in CR> Cash

Receipts> Enter Cash Receipts> Detail tab> Description column.

l The summary report will display the fund, general ledger account, general

ledger account description, debits and credits.  The report will also group and

total the report by fund and display report totals of the debit and credit

columns.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the GL distribution report. If any errors are discovered on the GL Dis-

tribution list you may be able go back and correct the receipts. This depends on the

security settings for your system.

l The GL distribution will display the net distribution when quick permits and quick

licenses are created. Debits and credits that result in a wash will not display in the

report.

l If the GL Distribution report is run in detail format, the report will display the net

effect on the GL by receipt.  If there is a positive and negative receipt line item for

the same charge type or GL account, the report will display the net distribution on

the GL account not the debit and debit to the same GL account.

l If a GL account has a debit and credit across different receipts, the report will

display each line item on the GL account not the net effect. The receipt line

items will only display as a net amount by receipt.

7     Print the UB Distribution List. 
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l Select UB GL Distribution from the Cash Receipts palette. This will open the UB

GL Distribution window.

l Enter the transaction date you want to appear in the General Ledger for this batch in

the Journal Entry field.  The journal entry date will determine the fiscal period in

which the receipts are recorded.

l Select the level of detail you would like to include on the report.

l The summary report will display the GL account number, description and

debit and credit amount.

l The detailed report will display GL account number and description, customer

number, fee code, debit and credit amount. The detailed version of the report

will also total by GL account number.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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l Review the report.

l If a deposit has been created in the batch, the UB GL Distribution will display

the debit to the GL cash account and the credit the GL liability account

attached to the UB deposit type fee code used to create the deposit.

l You can view the GL accounts attached to a UB fee code in UB> Main-

tenance> Fee Code> Open the deposit type fee code.

l The Cash Receipts column in the summary section of the report will display

any UB Cash Deposits created in the Cash Receipts batch.

8     Commit the Cash Receipts batch. 

l The final step in the Cash Receipts process is to commit the batch.  Select Commit

on the Cash Receipts palette. This will open the Commit window.

l The Batch field will display the batch number of the batch being committed.

l The Journal Entry Date field will display the journal entry date entered on the GL

Distribution step.

l The Fiscal Period and Fiscal Year fields will populate based on the journal entry

date entered in the Journal Entry Date field.

l Press OK to commit the batch.
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CR> Cash Receipts

Commit a Cash Receipts Batch

Summary

After the receipts have been entered into the Cash Receipts batch, print the reports and

commit the batch.

If you use the Bank Reconciliation module, you can use the Receipt Deposits process to

create Bank Reconciliation module transactions from the committed Cash Receipts.

Step by Step

1     Select a Cash Receipts batch you would like to commit. 

l Select a batch from the batch selection drop-down menu on the Cash Receipts

palette.

2     Generate a Proof List. 
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l The Cash Receipts Proof List Report will display all of the receipt line items

attached to the receipts in the batch totaled by payment type (cash, check, other).

Voided receipts will display on the Proof List, but VOID will display in the Void

column next to the receipt number. Voided receipts will also be totaled separately

on the report.

l Open the Proof List window (CR> Cash Receipts> Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l Select Detail to display a separate line item for detail line item on the receipt.

The detailed version of the report shows the receipt number, whether or not

the receipt was voided, customer number, date, customer name, cash receipt

type, description, receipt amount, and the amounts for cash, check, other,

change, net cash, and total. Each receipt is totaled, and the report has a

grand total.

l Select Summary to display a single summary line item for each receipt. The

report shows the receipt number, whether or not the receipt was voided, cus-

tomer number, date, customer name and the amounts for cash, check, other,

change, net cash and total. There is a grand total for the report.

l Select how the report should be sorted in the Sort By drop-down menu.

l Select Customer Number if you would like to sort the receipts that display on

the report by the customer number attached to the receipt.

l Select Receipt Number if you would like to sort the receipts that display on the

report by receipt number.

l Check the Include payment method summary toggle to include totals for each

pay method on the report.

COMMIT A CASH RECEIPTS BATCH 131



l When this toggle is checked, the report will display the Receipt Total, Void

Total and Grand Total amounts for each pay method included in the report.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l If the Cash Receipts Proof List was generated in detail format the report will display

the receipt number, customer information, and the service rates and fee codes paid

on the receipt.

l The Type column will display Service if the receipt line item reduces the bal-

ance on a service. If the receipt line item is paying a fee code, the Type

column will display Fee. If the receipt line item is creating a cash deposit, the

UB module deposit fee code will display in the Type column.

l If you generate in summary format, the report will display the receipt totaled

by payment type.
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3     Generate a BT Proof List. 

l Open the BT Proof List window (CR> Cash Receipts> BT Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l The Summary report will display the Receipt number, Invoice number, Busi-

ness number, Business Name, Calculated Amount, Payment Amount, Receiv-

able Amount, Credit Amount, Deposit Amount and totals for each amount.

l The Detail report will display everything included in the summary report as

well as the Fee, Fee Type, Unit Type, Number of Units, Excl Units and Subj

Units.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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4     Generate an LP Proof List. 

l Open the LP Proof List window (CR> Cash Receipts> LP Proof List).

l Select the level of detail to display on the report in the Report Type drop-down

menu.

l The Summary report will display the Receipt Number, Customer Name,

Invoice Number, Transaction Date, Transaction Type, Application Number,

License Number, Description, Invoice Amount, Payment Amount and Credit

Amount. A report total will also be provided for the Invoice Amount, Payment

Amount and Credit Amount columns.

l The Detail report will display everything included in the summary report as

well as the Fee Code, Fee Type, Unit Type, Number of Units and Detail

Amount for each line item.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the UB Proof List if there are Utility Billing module transactions in the batch. 

l If there are Utility Billing module payments or deposits in the Cash Receipts batch,

you will be required to print the UB Proof List. The UB Proof List Report is similar to

the Cash Receipts Proof List, but it will display the payment made to each UB mod-

ule service. Receipt line items on non-UB accounts or Cash Receipts module type

codes will not display on the report.

l Select UB Proof List from the Cash Receipts palette. There are no filter or sort

options on this report.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The UB Proof List will display the payment, all 20 UB services, and the portion of the

payment that is paid to each service. If a UB deposit is being created in the batch,

the service attached to the deposit type fee code will be billed a negative amount.

l The Transaction Type column will display the type of transaction created by

the receipt line item.

l Cash Deposit will display in the column if a cash deposit was created by

a receipt line item in the batch.

l The Transaction Date column will display the transaction date on the trans-

action and the date will be the same as the receipt date on the receipt.

l The Currency column will display the payment method (cash, check, credit

card, etc.) used on the receipt.

l Payment methods are created in the Cash Receipts module in CR>

Maintenance> Pay Method.

6     Print a GL Distribution List. 

l The GL Distribution Report will display the debit and credit amounts created by the

receipt line items included in the batch. If there are UB customer account payments

in the batch, the service rates, fee codes, and services on the transactions will dis-

play on the UB GL Distribution Report.
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l Voided receipts will not display on the report since they will not affect the general

ledger.

l Select Distribution List on the Cash Receipts palette. This will open the Receipt

Distribution Report window.

l The Journal Entry field will determine the fiscal period and fiscal year of the journal

entry generated by the batch.

l The journal entry date will default to the current date.

l The Fiscal Period and Fiscal Year fields are not enabled and will populate based

on the date entered in the Journal Entry field.

l Select the level of detail you would like to include on the report in the Report Type

drop-down menu.

l The Detail report will display the fund, general ledger account, general ledger

account description, receipt number, line item description, debits and credits.

The report will also group and total the report by fund and display report totals

of the debit and credit columns.

l The line item description of a receipt can be viewed in CR> Cash

Receipts> Enter Cash Receipts> Detail tab> Description column.

l The summary report will display the fund, general ledger account, general

ledger account description, debits and credits.  The report will also group and

total the report by fund and display report totals of the debit and credit

columns.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the GL distribution report. If any errors are discovered on the GL Dis-

tribution list you may be able go back and correct the receipts. This depends on the

security settings for your system.

l The GL distribution will display the net distribution when quick permits and quick

licenses are created. Debits and credits that result in a wash will not display in the

report.

l If the GL Distribution report is run in detail format, the report will display the net

effect on the GL by receipt.  If there is a positive and negative receipt line item for

the same charge type or GL account, the report will display the net distribution on

the GL account, not the debit and debit to the same GL account.

l If a GL account has a debit and credit across different receipts, the report will

display each line item on the GL account, not the net effect. The receipt line

items will only display as a net amount by receipt.

7     Print the UB Distribution List if there are Utility Billing module transactions in the batch. 
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l The UB GL Distribution Report is similar to the GL Distribution Report, but it can

include the service rates and fee codes that are being paid on UB module customer

accounts. The UB GL Distribution Report will only include journal entry line items

created by transactions on UB module accounts. Payments made to accounts other

than UB module accounts will not display on this report.

l Voided receipts will not display on the report since they will not affect the general

ledger.

l Select UB GL Distribution from the Cash Receipts palette. This will open the UB

GL Distribution window.

l The value in the Journal Entry Date field has no function. The journal entry date of

the journal entry created by the Cash Receipts batch is set by the GL Distribution

step, not the UB GL Distribution step.

l Select the level of detail you would like to include on the report.

l The summary report will display the GL account number, description and

debit and credit amount.

l The detailed report will display GL account number and description, customer

number, fee code, debit and credit amount. The detailed version of the report

will also total by GL account number.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the report.

l If a deposit has been created in the batch, the UB GL Distribution will display

the debit to the GL cash account and the credit the GL liability account

attached to the UB deposit type fee code used to create the deposit.

l You can view the GL accounts attached to a UB fee code in UB> Main-

tenance> Fee Code> Open the deposit type fee code.

l The Cash Receipts column in the summary section of the report will display

any UB Cash Deposits created in the Cash Receipts batch.

8     Print the PM Distribution report. 

l There are no print options for the PM Distribution report.

l The report will display the Task code, Task Description, Receipt Number, Debit

Amount, Credit Amount, Account Number and Account Description. The report will

also provide task and report totals.
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

9     Commit the Cash Receipts batch. 

l The final step in the Cash Receipts process is to commit the batch.  Select Commit

on the Cash Receipts palette. This will open the Commit window.

l The Batch field will display the batch number of the batch being committed.

l The Journal Entry Date field will display the journal entry date entered on the GL

Distribution step.

l The Fiscal Period and Fiscal Year fields will populate based on the journal entry
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date entered in the Journal Entry Date field on the GL Distribution step.

l Press ENTER or click the OK button to commit the batch.
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CR> Maintenance> Category

CR Category Maintenance

Summary

A CR module category is a group of type codes that can be added to a receipt and are gen-

erally used to make entering cash receipts more efficient.

There are generally three uses of categories:

l Group related type codes together that are usually charged together.

l Example: tax or fee associated with a certain type code.

l Since type codes can only be associated with one debit and credit GL account, type codes

can be grouped together into a category in order to charge multiple GL Accounts.

l Used to create a list of related type codes to choose from when entering a receipt.

To bill a category code on a receipt in the Cash Entry window, select Add New Category

from the drop-down menu on the Create icon while the Account/Category tab is open.

This will open a list of category codes.
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The transaction history created by the payment of the category code will not display on the

customer account history. If you would like to view the payment history of a category code,

generate a Receipt Listing Report (CR> Reports> Receipt Listing) and filter the report to

include that category code.

Step by Step

1     Open the Category Selection window (CR> Maintenance> Category Maintenance). 

l The Category Selection window displays all of the categories that have been cre-

ated in the database.

l Use the Status drop-down menu to filter the displayed categories by active or inact-

ive status.

l Press ENTER to open a highlighted category.

l
Press DELETE or click the Delete icon to delete the selected category.

l There is no validation on category codes. You will be able to delete category

codes that have been paid on receipts.

l
Press INSERT or click the Create icon to create a category. This will open the

Category Maintenance window.

2     Create a new category. 
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l Enter a Category. The category code can be up to 20 characters long.

l Enter a Description.  The description can be up to 25 alphanumeric characters

long.

l The Active toggle will be checked and disabled when you create a new category

code.  Users will not be able to generate receipts in the Cash Entry window using

inactive category codes.

l The Active toggle will be enabled when opening category codes that have

already been created. If you are creating a category code that should be inact-

ive, save the category code as active and then re-open the Category Main-

tenance window and uncheck the Active toggle.

l Press INSERT to add a type code to the category. This will open the Type Code

Selection window.

l Type codes can be created from the Type Code Selection window, but they

are generally maintained in CR> Maintenance> Type Code.

l
Highlight a type code and click the Modify icon to view the GL accounts

associated with a type code.

l The type code will be included on the receipt each time it is added to the cat-

egory, so if the type code is added more than once it will appear on the receipt

multiple times.

l Press ENTER to add the highlighted type code to the category.

l The Sequence column displays the order in which the type codes will be

added to the receipt. Change the value in the sequence column to change the

order in which the type codes display on the receipt. Sequence number zero
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will display first. An error message will display if a sequence number is

assigned to more than one type code on the category code.

l Each type code added to the category code will create a separate line item on

the receipt and will display separately on the Detail tab of the Cash Entry win-

dow.

l
Click the Save icon or press ENTER when complete to save the category code.
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CR> Maintenance> Display Receipts

View Receipts

Summary

The Display Receipts window is used to locate and open a receipt. If the receipt is uncom-

mitted, you can open and modify the receipt. You should restrict access to this feature if

you do not want users to have access to uncommitted receipts in any batch. Security can

be set up on specific menu options using the Menu Security feature (SS> Security> Menu

Security).

The Display Receipts window will display a list of receipts filtered by operator, station, CR

Cash Receipts batch number, amount, receipt date and/or receipt number. Uncommitted

and voided receipts will display in the window. You can export the receipts that display in

the window to an MS Excel spreadsheet by right-clicking on the information in the grid.

Step by Step

1     Locate a receipt. 
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l Open the Display Receipts window (CR> Maintenance> Display Receipts).

l Enter information into any of the fields in the Search Criteria section in order to filter

the receipts that will display in the window. These fields can accommodate both full

and partial field details. You can enter information into as many of the filter fields as

you would like.

l The Station drop-down menu is used to filter receipts by the CR station that was

used to create the receipt.

l The Station drop-down menu will display all stations that have been created in

CR> Maintenance> Station.

l If a receipt is modified on another station before it is committed, the receipt

will still be filtered by the station that was used to create the receipt.

l The Operator drop-down menu is used to filter receipts by the CR Operator that cre-

ated the receipt.

l The Operator drop-down menu displays all of the operators created in CR>

Maintenance> Operators.

l If a receipt is modified by another operator before it is committed, the receipt

will still be filtered by the operator that created the receipt.

l Click the Batch Number field label to filter the receipts that display in the window by

Cash Receipts batch.

l Enter a value in the Amount field to filter the receipts that display in the window by

receipt amount.

l The Reference Number field is used to filter the receipts that display in the window

by the reference number attached to the receipt.
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l Reference numbers are attached to receipts when entering a payment type in

the Payments section of the Cash Entry window.

l The Customer Number field list is used to filter the receipts by customer number.

Click the Customer Number field label to select a customer number from a list win-

dow.

l This field will filter the receipt by customer record number, not customer

account number. For example, if a customer has two UB module customer

accounts (000001-001, 000001-002), receipts for both of those customer

accounts will display in the window.

l The Receipt Status drop-down menu is used to filter the receipts by voided and

valid receipts.

l Receipts are voided from the Cash Entry window by clicking on the Void icon

.

l Receipts cannot be voided after they have been committed.

l The Receipt Date From and Receipt Date To fields are used to filter the receipts

that display in the window by receipt date.

l The receipt date is entered in the Date field in the Receipt Information section

on the Cash Entry window when the receipt is being created.

l The receipt date is not necessarily the same date the Cash Receipts batch is

created, or the journal entries are posted to the General Ledger.

l The Receipt Number From and Receipt Number To fields are used to filter the

receipts that display in the window by receipt number.

l Depending on how the Cash Receipts module is set up, receipt numbers can

either be automatically generated when the receipts are saved, or created by
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the user when a receipt is entered (Auto number receipts toggle in CR> Util-

ities> Setup).

l Receipt numbers are entered in the Receipt Number field in the Receipt

Information section on the Cash Entry window.

l The Receipt Status drop-down menu is used to filter the receipts by voided and

valid receipts.

l Receipts are voided from the Cash Entry window by clicking on the Void icon

.

l Receipts cannot be voided after they have been committed.

l The Commit Status drop-down menu is used to filter the receipts that display in the

window by committed and uncommitted receipts.

l A receipt is committed once the batch the receipt it belongs to is committed in

CR> Cash Receipts> Commit.

l The AR, BP, BT, LP, PT and SA fields can be used to filter the displayed receipts by

module specific information.

l
Click the Refresh icon to apply the filters in the Search Criteria section to the

receipts that display in the window.

l Right click on the data in the window and select Export grid contents to Excel to cre-

ate an MS Excel spreadsheet of the information in the window. This allows you to

create a report that displays a filtered list of receipts.

2     Open a receipt. 
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l Double click on any receipt in the window to open the receipt. This will open the

receipt in the Cash Entry window. You cannot modify or void a receipt from the Dis-

play Receipts window.

l
Click the Print icon to print the receipt. This will print all of the default slips

set up on the Slip Maintenance window (CR> Maintenance> Slip> Main-

tenance section> Default Slip toggle). Slips that are attached to payment

types or type codes will not print. If you want to print the slips attached to a

payment method or type code click the Print Slip icon .

l
Click the Print Slip icon to print a specific slip that has been set up in the

Slip Maintenance window (CR> Maintenance> Slip).

l Double click on an account on the Account tab to open an account attached to

the receipt.
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CR> Maintenance> Operator

CROperator Maintenance

Summary

The Operator Maintenance window is used to select which Springbrook application user

accounts are authorized to enter Cash Receipts. In order for a Springbrook application

user to create a receipt using the Cash Receipts module, the user must be set up as a

Cash Receipts module operator. There are several Cash Receipts module setup features

that are attached to the operator record such as receipt printing options and stations that

an operator is authorized to enter cash receipts on. Stations are created and maintained in

CR> Maintenance> Station.

Step by Step

1 Open theOperator Selection window (CR> Maintenance> Operator Maintenance). 

l The Operator Selection window displays all of the Cash Receipts module operators

that have been set up in the database.

l Use the arrow keys on the keyboard to change the highlighted operator and press

ENTER to open the selected operator. This will open the Operator Maintenance win-

dow.
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l You can also open an operator by double clicking on the record.

l Press DELETE to delete the highlighted operator.

l Deleting an operator will delete the operator record, it will not delete the

Springbrook Application user account.

l There can be only one operator record set up for each Springbrook applic-

ation user.

l Press INSERT to create a new operator. This will open the Operator Maintenance

window to enter the operator information.

l
You can also create a new operator by clicking the Create icon .

l In order to create a new operator, the operator must have a Springbrook

application user account created in SS> Security> User.

2 Create an operator in the Operator window. 

l Select a Springbrook application user from the Operator Code drop-down menu.

The Operator Code is the username that will be used when the operator logs into

the Cash Entry in CR> Cash Receipts> Cash Entry.

l Only Springbrook application users will display in the Operator Code drop-

down menu. If the operator code you would like to select is not in the drop-

down menu you can create a new Springbrook application user in SS> Secur-

ity> User> Create a new user.

l There can be only one operator set up for each Springbrook application user

account. You will be able to select a Springbrook application user from the

CR OPERATOR MAINTENANCE 153



Operator Code drop-down menu that has already been set up as an oper-

ator, but you will not be able to save the operator record.

l The Name field will populate with the description that has been entered on the

Springbrook application user in SS> Security> User> Description field. You can

modify the Name field and the Springbrook application user record will not be

affected by the change.

l The Name field is limited to 30 alphanumeric characters.

l Check the Manager toggle if the operator should have access to all CR Cash

Receipts module batches.

l If the Manage toggle is checked, the operator will be able to access all CR

Cash Receipts batches even if the Single Operator Per Batch toggle is

checked in the CR Setup (CR> Utilities> Setup Cash Receipts).

l Check the Automatically print receipt on save toggle if you want to print a paper

receipt for each cash receipt entered.

l The slips attached to the payment type will print at the receipt printer on the

workstation when the operator clicks the Save icon on the Cash Entry win-

dow.

l Check the Automatically print receipt on save toggle if you would like

every receipt created in the Cash Entry window to generate a slip.

l The selection in the setup toggle will only affect the selected operator.

l Check the Open cash drawer after save toggle if you want the cash drawer to

open automatically at the end of each transaction.

l
There is a Cash Entry icon on the Cash Entry window which allows an

operator to open the cash drawer.
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l Check the Automatically print duplicate (copy) receipt toggle if you would like a

duplicate receipt printed for each slip generated by a transaction. This option is gen-

erally used by organizations that would like to keep a copy of each receipt for their

own records.

l If there are multiple slips that print on a receipt, a copy of each slip will print.

l Check the Pause printing between receipts toggle if you want an information win-

dow to open between printing the receipts. This option is generally used with the

Automatically print duplicate (copy) receipt toggle but it can function on its own.

l After a receipt is printed, an information window will open asking if you would

like to print the next receipt. This feature will function no matter how many

slips will print.

l The information window gives the user the option to cancel the printing of the

next receipt.

l Check the Allow modification of GL accounts toggle to give the selected oper-

ator the ability to edit GL debit/credit accounts on CR transactions.

l WARNING: Modifying GL accounts should be limited to Misc CR transactions

that are created through CR Type Codes or CR Category Codes.

l The Stations section of the Operator window is used to select which CR Stations an

operator can use when entering cash receipts using the Cash Entry process in CR>

Cash Receipts> Cash Entry. A Station is a computer that is used to enter cash

receipts and is set up in CR> Maintenance> Station. If CR Operators are using the

Enter Receipts window in CR> Cash Receipts> Enter Receipts to enter receipts, the

operators will not be limited to the stations that are in the Stations section on the

Operator maintenance window.
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l Operators can also be added to stations on the Station maintenance window

in CR> Maintenance> Station. All stations that have been attached to oper-

ators in the Station maintenance window will display in the Station section of

the Operator maintenance window.

l Press INSERT to add a new station to the operator. This will open the Station

Selection window.

l Only stations that have been created in the Cash Receipts module will

display in the Station Selection window.

l
Click the Create icon or press INSERT to create a new station. Sta-

tions can also be created in CR> Maintenance> Stations.

l Highlight a station in the Stations section of the Operator window and press

DELETE to remove a station from an operator. This will not delete the station,

it will only remove the station from the list of stations the operator is author-

ized to use.

3 Click on the Confirm icon or press ENTER when complete.
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CR> Maintenance> Pay Method

CR Pay Method Maintenance

Summary

Pay methods are used to define what kind of payment is received when creating a receipt

in the Cash Entry window. The most common pay methods created are Cash, Check, Wire,

Electronic Funds Transfer (EFT) and Credit Card.

Slips can be attached to payment methods if you would like a specific slip to print when a

certain payment method is used. Slips attached to the payment method will always print

when a receipt is generated using that payment method. If there are default slips set up in

the Slip Maintenance window (UB> Maintenance> Slip) and receipts are set up to print on

save in the Operator Maintenance window (UB> Maintenance> Operator), the default slips

will print first followed by the slips attached to the payment method. You can also attach a

slip to a type code if you would like a specific slip to print on a specific type code. (UB>

Maintenance> Type Code).

Once the payment methods have been created, you should set up a default payment

method in CR> Utilities> Setup> Default Payment Method drop-down menu. Payments
received in the Cash Entry window will default to the payment method when a receipt is cre-

ated.
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The Payment Method Listing Report (CR> Reports> Payment Listing Report) allows you to

group receipts by payment type.

Step by Step

1 Open the Pay Method Selection window (CR> Maintenance> Pay Method). 

l Press DELETE to delete the highlighted payment method.

l Highlight a payment method and press ENTER to open the selected payment

method.

l Press INSERT to create a new payment method. This will open the Pay Method

Maintenance window.

2 Create a pay method. 

l Enter a Payment Method. The Pay Method field can be up to 20 alphanumeric

characters and will be used to identify a payment type from a drop-down menu.

l Enter a Payment Method Description. This field can be up to 25 alphanumeric char-

acters long.

l Select a payment method in the Type drop-down menu. The pay method type

determines how the payments of payment methods will be grouped together on the
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Cash Receipts Proof List (CR> Cash Receipts> Proof List) and the Receipts Listing

Report (CR> Reports> Receipt Listing).

l If you would like to group payments by payment method rather than type, gen-

erate a Pay Method Listing Report (CR> Reports> Pay Method Listing).

l Enter an optional Cash GL Override account for the pay method or click the field

label to select one from a list. This can be a full account or a partial account.

l When this payment method is used, this account will override the default cash

account associated with the relevant rate, fee or type code. This is often use-

ful when processing credit card payments, as there may be a delay in recon-

ciling those transactions when compared to cash or check payments.

l If a pay method with an attached Cash GL Override is used in the Cash

Receipts process, that CR receipt will be limited to one pay method. If addi-

tional pay methods need to be used, additional receipts will need to be cre-

ated.

3 Attach a slip to a payment method. 

l Slips attached to a payment type will always print when receipts are saved. If there

are default slips set up in the Slip Maintenance window (UB> Maintenance> Slip)

and receipts are set up to print on save in the Operator Maintenance window (UB>

Maintenance> Operator), the default slips will print first followed by the slips

attached to the payment method.

l If there are slips attached to a type code on the receipt they will print as well.
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l Press INSERT to add a slip to the payment method. This will open the Slip Selection

window.

l Select the specific Slip to print with this Pay Method or create a new slip.

l Click the right border of the window (the border will change colors when you

hover the mouse over it) to display the Maintenance section of the window.

l Highlight a slip and press ENTER to add a slip to the payment method.

l Each slip will be assigned a print order when it is attached to a payment method.

The print order determines the order that the slips will print when a receipt is cre-

ated.

l Change the value in the Print Order column in order to change the order in

which the slips will print.

l
Click on the Save icon or press ENTER to save your work.
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CR> Maintenance> Query by Example

Create a QBE Report in CR

Summary

The QBE Builder reporting tool is used to create customized reports in the Cash Receipts

module. Reports are created in the QBE Builder by selecting columns, creating arguments

to remove records (Transaction Date < 01/01/2021), selecting how the report will group

and sort, and then defining the totals that will display on the report. After the report has

been created, it can be printed out or exported into an MS Excel, MS Access or CSV

format. Reports that have been created using the QBE Builder tool can be saved and gen-

erated at any point.

This document will cover how to create a specific example report that provides an explan-

ation of primary tables, secondary tables, arguments and totals. When creating your own

QBE reports, it is helpful to know the general structure of the database and how the inform-

ation entered into the fields on a window will be stored in the database fields and tables.

The Table/Field help feature (Help> Table/Field) is designed to be used in conjunction with

database security (SS> Security> DB Security), but it can be helpful when building QBE

Reports to help you determine where the information entered into a field on a window is

stored. This tool will not always be helpful because it will display the exact name of the

table and field where the information is stored, but QBE Builder uses simplified and more

intuitive field and table names.
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The report we will create in this example is a report that shows all the cash transactions

that were $59.00. Every module with a QBE reporting tool offers a different example report,

so if the report you want to create is different or more complicated than the report created

in this example, refer to the QBE examples in other modules for more help. The QBE

Report feature works the same in all of the modules, but the information that is available to

report on is different from module to module.

Step by Step

1     View the QBE Reports. 

l Open the QBE Maintenance window (CR> Maintenance> Query by Example).

l The QBE Maintenance window will display all of the reports that have been created

in the CR module. Select a report in the left section of the window and the cus-

tomized report information will populate in the right section of the window just like

many of the other maintenance windows in the application.

l Highlight a report and press DELETE to delete the highlighted report.

l
Click the Create icon or press INSERT to create a new QBE report.

l
Highlight a report and click the Print icon to print an existing QBE report. The

QBE report will be generated as soon as the resources are available on the server.

You can view the progress of the print job using the Jobs Viewer window (Jobs

Viewer icon on the main application window).
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l
Highlight a report and click the Export icon drop-down and select Export Report

to export the highlighted report data.

l
Highlight a report and click the Export icon drop-down and select Export Defin-

ition to export the report definitions of the highlighted report. This exported report
definition file can then be imported using the Import icon . This allows organizations

to share QBE reports.

2     Select the tables that contain the information you would like to include on the report. 

l The first step in creating a customized report is selecting the information you would

like to display on the report. Information in a database is organized into tables and

fields. Fields are used to store specific information, such as customer names. Fields

are then grouped into tables. For example, a grouping could consist of a customer

table that contains all of the general customer information, such as address and

phone number. When information is entered into a window in the application, that

information is stored in a specific field within a specific table. When creating a QBE

report, select the tables that contain the information you would like to include on the

report and then select the fields.

l Select a table from the Table Name drop-down menu in the Primary Table section.

The Available Fields section will populate with the fields grouped into that table. If

the table you select does not contain all of the fields you want to report on you will

have to select a secondary table.

l Some tables in the database are linked together because they share a common

field called a key. The key connects the data in the two tables together and defines
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how the data in one table is related to the data in another table. If the table you

selected in the Table Name drop-down menu in the Primary Table section is linked

to other tables, you can select a secondary table in the Secondary Table section. As

you select a secondary table from the Table Name drop-down menu, new fields will

be added at the bottom of the Available Fields section. If you need information from

two different tables, but those tables are not linked together, you will not be able to

create the report.

l From the Table Name drop-down menu in the Primary Table section, select

Receipt.

3     Select the fields you would like to include in the report. 

l After you have selected the tables you can pull the fields from those tables onto the

report. Check the toggles of the fields you would like to include on the report in the

Available Fields section. Only fields with a check will display on the report.

l In the Available Fields section, check the Customer Number, Name and Amount

toggles. These are the columns that will show up in the report.

4     Create a filter argument for the report. 

l The fields below the Table Name drop-down menu are used to create an argument

that will filter the information that will display on the report.
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l In order to filter the report to only include cash transactions equal to $59.00, we

need to create an appropriate argument. These arguments are limited to 2048 char-

acters.

l Select Cash Amount from the first drop-down menu directly below the Table

Name field. Selecting a value for this field activates the two fields to the right.

l The next field contains the operators that will give the argument meaning.

Select Equals from this drop-down menu.

l Type 59.00 in the third argument field.

l Click the Add button to save the argument to the Primary Table field.

l
Click the Test Query icon to confirm that the query is valid.

l Enter the arguments in the Secondary Table section.

l When you enter an argument in the Primary Table and the Secondary Table

section the arguments will be joined with an AND statement, meaning records

must meet the conditions in both section before they will display on the report.

l Our example does not use a secondary table.

l The AND and OR buttons will be enabled after you add the argument to the

report. The AND and OR buttons are used to link the conditions of an argu-

ment together so you can build more complicated filtering.

l Our example does not use the AND or OR function.

l The brackets are used to define the order in which the AND and OR

statements will be applied. Arguments within brackets will be calculated

before arguments outside of brackets. For example, you can create an

OR statement inside an AND statement using the following format:

(statement 1 OR statement 2) AND (statement 3 OR statement 4). The
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OR statements inside the brackets will be processed first, and then the

AND statement will be applied.

5     Set the number of records that will display on the report. 

l The Limit field in the Primary Table section is used to define the maximum number

of records that will display on the report. If you set this value to a very large number

(99,999,999,999) you run the risk of creating a report that will take a long time for

your server to process.

l Enter 100 in the Limit field to limit our cash transactions report to 100 results.

6     Modify the report layout. 

l After the fields have been selected and the arguments have been entered on the

report you are ready to set up the report layout. The report layout allows you to

define how the report will be grouped and totaled, and also allows you to select

which fields will total.

l
Click the Modify Report Layout icon to open the QBE Layout window.

l Move the columns that display in the QBE Report Layout section to change the

order in which the information will display on the report.

l Move column headings to the section above the column headings to change how

the information is grouped on the report.

CREATE A QBE REPORT IN CR 166



l The Column Totals section is used to select which columns should be totaled on

the report. Check the toggle of the totals you would like to include on the report.

l Only columns that would provide a meaningful total will be available in the

Column Totals section.

l
Click the Save icon when complete to save the report layout. The QBE report

will print in the saved format when the report is generated.

7     Save the report. 

l Enter a name for the report in the Report Name field.

l
Click the Save icon when complete.

8     Print or export the report. 

l
Press ENTER or click the Print icon to generate the report.

l You can view the progress of the report on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

l
Click the drop-down arrow next to the Export icon to select the export format. A

window will open allowing you to select the path where the exported file will be cre-

ated.
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l If your report appears to be missing information but your filters seem to be correct,

make sure the Limit field in the Primary Table section contains a large enough num-

ber to contain all of the records you want to include in the report.
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CR> Maintenance> Slip Maintenance

CR Slip Maintenance

Summary

Slips are receipts and endorsements that will print from a receipt printer when a receipt is

created in the Cash Entry window.  The term slip is a generic term that refers to both check

endorsements and receipts. The Slip Maintenance window (CR> Maintenance> Slip) is

used to create and maintain receipts and endorsements.

There are three ways to determine which slips will print out when a receipt is generated in

the Enter Cash Receipts window.

l Check the Automatically print receipt on save toggle on the Operator Maintenance win-

dow (CR> Maintenance> Operator) to print all slips that are set up as default receipts in the

Maintain Slips window (CR> Maintenance> Slip). If there are no default slips set up, no slips

will print.

l If the Automatically print receipt on save toggle is not checked in the Operator Main-

tenance window, the default slips will not print when receipts are saved in the Cash Entry win-

dow.
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l Slips attached to a payment method will print when that payment method is used on the

receipt. Slips are attached to payment methods in the Payment Method Maintenance window

(CR> Maintenance> Pay Method).

l You can attach a slip set up as an endorsement to a check payment type so that the

endorsement will print when the check payment type is used on a receipt.

l Slips attached to a type code will print when that type code is added to a receipt. Slips are

attached to type codes in the Type Code Maintenance window (CR> Maintenance> Type

Code).

All three of these methods can be used in conjunction, but the slips that are set up as

default slips in the Maintain Slips window will always print before the slips that are attached

to payment method or type code. The slips will print on the printer set up on the workstation

in the Station Maintenance window (CR> Maintenance> Station).

Step by Step

1     View the slips that have been created. 

l Open the Slip Maintenance window (CR> Maintenance> Slip).

l The Slip Maintenance window will display all of the slips that have been created and

can be attached to a Pay Method (CR> Maintenance> Pay Method).
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l Select a slip in the left section of the window and the fields in the Maintenance sec-

tion will populate with the information from the selected slip. The Slip Text section

will display the fields on the receipt and the format that the receipt will print in.

l
Click the Print icon to print a preview of the receipt using the receipt number

entered into the field next to the Print icon.

l The receipt will print using the receipt printer set up on the station that you are

logged in at. You will receive an error message if you are not logged into a

computer that is set up as a station in the CR module (CR> Maintenance> Sta-

tion).

l The receipt printer of a station is set up in the Station Maintenance window

(CR> Maintenance> Station> Printer Name field).

l Highlight a slip and press DELETE to delete the selected slip.

l You cannot delete a slip that is attached to a payment type.

l Press INSERT to create a new slip. This will add a new line item to the Slip Main-

tenance window and the fields in the Maintenance section will be blank.

2     Create a new slip. 

l Enter a Slip Name. The slip name can be up to 40 characters long.

l You will not be able to modify the slip name after the slip has been saved.

l Check the Default Slip toggle if the receipt should print for all receipts. If there is a

default slip defined and a slip is also attached to the pay method, when the receipt is

saved, both receipts will print.
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l Check the Endorsement toggle if the slip should be printed on a piece of paper slid

into the printer like a check.

l You can attach endorsements to a check payment type so that the endorse-

ment will print each time the check payment method is used in a transaction.

l An endorsement can be attached to a payment type in the Payment Method

Maintenance window (CR> Maintenance> Payment Method).

l Select the fields you would like to display on the receipt by moving fields from the

Codes field to the Slip Text field.

l The Slip Text field contains the names of the fields and the control codes on

the slip. You can also type information directly into the Slip Text field and the

text will display on the receipt. City, organization name, address, telephone

number and business hours are all examples of text that is sometimes

entered onto a receipt.

l The total number of characters per line in the Slip Text field cannot

exceed the characters per line specified on the Station Maintenance

window (CR> Maintenance> Station> Characters Per Line field). If the

total number of slip text AND code value characters on a single line

exceeds this number, the slip text will be truncated in favor of the code

value on the slip.

l The Codes field displays all of the fields and control codes that can be added

to a slip. Double click on a field to add it to the receipt. The field will appear in

the Slip Text field surrounded in brackets. When the receipt is printed, the

field name will be replaced with information from the receipt. Adjust the place-

ment of the field on the receipt to affect the alignment of the receipt.
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l The Control Codes <#> field may be required to send the receipt

printer commands such as when to cut a receipt or if a slip is an

endorsement rather than a receipt. Control Codes vary depending on

the brand and model of your receipt printer, so please refer to your

receipt printer’s manual for information on your specific control codes.

Springbrook can also provide assistance for some receipt printers.

l When you add a control code to the slip, it will look like this [Control

Code <#>]. Replace the # between the <>'s with the control code value

you would like to send to the printer. This is generally a two digit number

such as 45.

l The Time and Date fields are the current time and date. This is not the

same as the receipt time and date.

l The Receipt Time and Receipt Date are the time and date that the

receipt was first created.

l The Messages 1, 2, 3, 4 and 5 fields are the messages that are entered

on the Messages/Notes tab of the Cash Entry window when a receipt is

being created.

l The All Accounts & Address field will be substituted with all the

accounts and their associated lot addresses when the slip is printed out.

The field will display the street number, directional and street name.

The city, state and zip will not display when using this field.

l The difference between “Right Just.” And “Simple” fields is that the

“Right Just.” Fields will be right justified based on the number of char-

acters per line of the receipt printer set up on the station. The “Simple”

fields will display where they are placed in the Slip Text field.
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l The All Line Items & GL w/Description field will display the GL account

number, GL account description, charge description, and payment

amount.  The GL account number and description will each be on their

own lines followed by the charge description and payment amount on

the last line.

l The Payment Provider, Payment ID, and All Payments & Reference

codes are used to include credit card terminal payment data on the slip.

l The Payment Provider and Payment ID codes will display the pro-

vider and ID number associated with the credit card payment on

the slip.

l The All Payments & Reference code will list each receipt payment

as a separate line on the slip, including the amount, pay method,

and reference number. Because these lines will be displayed in a

table format, be sure to place this code on a new line on the slip.

l
Click the Print icon to preview the receipt you just created. The preview will print

a preview of the Receipt Number entered in the field next to the Print icon.

l
Click the Save icon to save the slip when complete.
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CR> Maintenance> Station

CR Station Maintenance

Summary

The Station Maintenance window (CR> Maintenance> Station) is used to set up which

workstations on the network can be used to enter receipts (CR> Cash Receipts). A work-

station must be set up before receipts can be created on that computer. You can only cre-

ate or modify the station that you are currently logged into using the Station Maintenance

window. You can only modify the setup of the station you are logged into.

Step by Step

1 View the stations. 

l Open the Station Selection window (CR> Maintenance> Station Maintenance).

l The Station Selection window will display all of the stations that are currently set up

in the Cash Receipts module.

l Double click on a station in the window to open the Station Maintenance window for

the selected station.
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l You can also open a station by selecting a station using the arrow keys on the

keyboard and then pressing ENTER to open the highlighted station.

l You cannot make modifications to a station that you are not logged into. If you

open a station you are not logged into, all of the fields in the window will be dis-

abled.

l
To create a new station, click the Create icon . This will open a blank Station

Maintenance window.

l You can also create a new station by pressing INSERT. This will open a blank

Station Maintenance window.

l You can only create a station record for the station you are logged into.

2 Create a station. 

l The Station field will display the name of the station that you are currently using.

You will not be able to modify the value in this field.

l You can only create a station in the Cash Receipts module that you are using.

l Enter a Description of the station. This field can be up to 25 alphanumeric char-

acters.

l The Drawer Code field is used to enter the control codes for the cash drawer. Enter

the control codes separated by a comma. Do not include any spaces before or after

a comma.
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l If there is a specific cash drawer connected to this station, enter the control

code in the Drawer Code field. Control codes vary depending on the model

and brand of the cash drawer but are generally two digits long and separated

by a comma.  Please refer to the user manual of the cash drawer for addi-

tional information on the control codes. Springbrook Support can also provide

assistance for certain models and brands of cash drawers.

l The Drawer Port/File field is used to set up a cash drawer for the station.

l Enter a file name in this field to run a file instead of accessing a port directly. 

Some cash drawers (like USB models) require running an executable file to

open the drawer.

l
After the cash drawer has been set up, you can click the Open Cash Drawer icon to

open the new cash drawer.

l The Terminal IP Address and Terminal Port fields are used to set up an optional

point-of-sale credit card terminal for accepting counter payments through the sta-

tion.

l The Terminal IP Address field is used to set the static IP address for your

credit card terminal. Please consult your IT team, as the IP address must be

set locally.

l The Terminal Port field is used to enter the port assigned to the credit card ter-

minal. This number can be found on the terminal itself by following the instruc-

tions in the link below.

l These fields will only be active if credit card terminals are enabled on the CR

Setup window (CR> Utilities> Setup> Card Terminals tab> Enable Card Ter-

minal Interface toggle).
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l
The Check Credit Card Terminal Connection icon is used to test the con-

nection between the station and the credit card terminal once the setup is com-

plete. When clicked, the system will test the connection and display the test

results in a pop-up window.

l The Printer Mode drop-down menu determines how you will select the receipt

printer for the station.

l When selecting a receipt printer that uses control codes, use the DIRECT

option because this option works for almost all receipt printers. If the DIRECT

option does not work, select the DOS option. The DOS option will work for all

receipt printers but will add white space to the receipt. Do not select the

WINDOWS option if the receipt printer uses control codes.

l Select DIRECT from the Printer Mode drop-down menu to select a receipt

printer by port. This will enable the Printer Port drop-down menu to select a

printer.

l Select DOS from the Printer Mode drop-down menu only if the DIRECT option

does not work. This option will add white space to the receipt and should only

be used if the DIRECT option does not work.

l Select RAW TEXT from the Printer Mode drop-down menu to connect a USB

printer. This will enable the Printer Name field and disable the Printer Port

field.

l Select WINDOWS from the Printer Mode drop-down menu to select a printer

by printer name. This will enable the Printer Name field and disable the Printer

Port field.

l This option should only be used when selecting a non-receipt or net-

work printer.
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l The Printer Name field is used to select the slip printer of a station if WINDOWS is

selected in the Printer Mode drop-down menu. All printers that have been set up in

MS Windows will display in the Printer Name drop-down menu.

l If the desired printer does not display in the Printer Name drop-down menu,

make sure the printer has been added to the workstation in MS Windows.

l If you create a new printer in MS Windows while the Station Main-

tenance window is open, the new printer will not display in the Printer

Name drop-down menu until you close and reopen the Station Main-

tenance window.

l The Printer Port drop-down menu is used to select the slip printer port if DOS or Dir-

ect is selected in the Printer Mode drop-down menu.

l This values displayed in this drop-down will vary from organization to organ-

ization. These values must be at least three characters in length.

l The Characters Per Line field is used to determine the number of characters dis-

played per line and the ending point for right-justified parts of the receipt.

l Number of characters displayed - This field limits the number of characters

that can display on a single line of the receipt.

l The number of characters that can display on a line will vary depending

on the receipt printer specified in the Printer Name field above, but 30 is

a common value entered in this field.

l If the total number of slip text AND code value characters on a single

line exceeds the value in the Characters Per Line field, the slip text will

be truncated. The text WILL NOT wrap to the next line.

l Ending point for right-justified merge fields - This field determines the right

side ending point for right-justified fields, such as receipt line item amounts
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and receipt totals.

l As stated above, the total number of slip text AND code value char-

acters on a single line cannot exceed the value specified in the Char-

acters Per Line field.

l The Authorized Operators section is used to select which operators are author-

ized to create receipts on the selected station. Operators can also be attached to

workstations on the Operator Maintenance window (CR> Maintenance> Operator).

l
Click the Create icon or press INSERT to add an operator to the station. This

will open the Operator Selection window. The Operator Selection window will

display all operators that have been created in CR> Maintenance> Operators.

If a Springbrook user has not been set up as an operator, the Springbrook

user will not display in the Operator Selection window.

l
Click the Confirm icon to select the operator.

l Highlight an operator in the Authorized Operators section and click the Delete
icon or press DELETE to remove a user from the workstation. This does not

delete the operator, it only removes the operator from the list of authorized

operators.

l If you highlight a user and press DELETE in the Operator Selection win-

dow the operator will be removed from the database.

l
Click on the Save icon to save the station.
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CR> Maintenance> Type Code

CR Type Code Maintenance

Summary

Type codes create a single line item when they are added to a receipt on the Detail tab of

the Cash Entry window and have four main uses: charge for miscellaneous items such as

copy machine fees, create a deposit on a UB module customer account, record a cash

drawer over/short amount, or record bank fees.

When a type code is attached to a receipt on the Detail tab of the Cash Entry window, a

detail line item will be added to the receipt that will debit and credit the GL accounts

attached to the type code. The type code receipt line item will not generate a history item

on any customer account (Utility Billing, Accounts Receivable, etc.) attached to the receipt

unless the type code is creating a deposit on a UB module customer account.

Only one debit and credit GL account can be associated with a single type code. If you

would like to associate multiple general ledger accounts with a type code, create a type

code for each debit and credit GL account you would like to affect in the transaction and

then group those type codes into a category code. Type codes can be grouped together

and added to the receipt at one time using category codes (CR> Maintenance> Category).

Category codes are added to a receipt using the Account/Category tab of the Cash Entry

window and all of the type codes grouped onto the category code will be applied to the

receipt.
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Type codes can be used to record over and short cash drawer adjustments to get the Cash

Receipts Proof List Report to match the amount of the receipts in the cash drawer. Create a

type code with the debit and credit GL accounts you would like to affect with the trans-

action, and check the Allow Negative Amount Receipts toggle in the CR Setup Window

(CR> Utilities> Setup Cash Receipts) so that you can create negative amount receipts.

When there is an over or short in a Cash Receipts batch, create a receipt in the batch and

add the over/short adjustment type code to a receipt that is not attached to a customer

account. Use the Amount to Pay column on the Detail tab of the Cash Entry window to

adjust the amount on the Cash Receipts Proof List to match the receipts in the Cash

Drawer.

Type codes can also be used to enter bank fees. Entering the bank fee amounts in the

Cash Receipts module means that the bank fees will display in the Bank Reconciliation

module.

There is a separate help document that explains how to create a deposit on UB customer

accounts with a CR type code.

The Receipt Listing Report (CR> Reports> Receipt Listing) can be filtered by type code

and will display the type code line items and receipt information, including the customer

information.

Step by Step
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1     View the type codes. 

l Open the Type Code Maintenance window (CR> Maintenance> Type Code).

l Open a type code.

l Use the arrow keys on the keyboard to highlight a type code and press

ENTER to open the highlighted type code.

l You can also open a type code by double clicking on it with the mouse.

l Delete an existing type code.

l
Highlight a type code and press DELETE or click the Delete icon to delete

a type code.

l You will not be able to delete a type code that is attached to a CR module

receipt.

l If you would like to make the type code unavailable in the Cash Receipts Input

window, you can change the status of the type code to inactive.

l Uncheck the Active toggle in CR> Maintenance> Type Code.

l Create a new type code.

l Press INSERT to create a new type code. You can also create a new type

code by clicking on the Create icon . This will open the Type Code Main-

tenance window.

2     Complete the Type Code Maintenance window. 
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l Select a Type from the drop-down menu.

l Select Standard to create a type code that will be used to add standard fees to

a receipt.

l Select Tax to create a type code that will be used to apply taxes to Standard

type codes.

l This will disable the Amount field below and enable the Percentage

field. This is the only type code that uses the Percentage field.

l You must create a Tax type code first in order to add taxes types to

Standard type codes.

l Select UB Deposits to create a type code that will be used to create UB cash

deposits.

l This will disable the Debit and Credit Account fields.

l Enter a Type Code. The type code can be up to 20 alphanumeric characters long.

l The type code will display on the Cash Receipts Proof List in the Type column

when receipt line items are generated using the type code.

l Enter a Description of the type code.  This field can be up to 25 alphanumeric char-

acters long. If this is a UB deposit, the description does not have to be the same as

the description on the special charge code.

l If this type code is usually the same dollar amount, enter that amount in the Amount

field. If the amount varies, leave this field at 0.00.

l When you are creating a new type code the Active toggle will be checked and will

be disabled. The Active toggle will be enabled if you are modifying an existing type

code.

CR TYPE CODE MAINTENANCE 184



l If you uncheck the Active toggle, the type code will still display in the Type

Code Selection window (CR> Cash Receipts> Enter Receipts> Details tab>

Create/New icon), but it will be marked as inactive.

l Enter a Percentage if you are creating a Tax type code.

l Enter the General Ledger Accounts where this type code line item should be recor-

ded.

l The Debit account is usually a cash GL account and the Credit account is usu-

ally a revenue GL account if the type code is going to be used to record the

receipt of cash for a purchase.

l This will be the only journal entry created by the type code line item.

Any expenses associated with the line item, such as inventory, will have

to be expensed separately. If you would like to expense the adjustment

type, you can create another type code to create the expense journal

entry line items and then group the cash and expense type codes

together on a category code (CR> Maintenance> Category).

l The field in the General Ledger Accounts section will not be enabled if the UB

Deposit Type toggle is checked.

l The Task and Type fields are used to track receipts on the task and type code in the

Project Management module. These fields will only be enabled if the PM module is

set up to interface with the CR module.

l Check the Project Management Interface toggle (CR> Utilities> Setup) to

enable the PM module Task and Type code fields on the type code.

3     Attach a slip to the type code. 
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l Specific Slips can be attached to a Type Code. For example, you may have a gen-

eric receipt that prints for most cash receipts, but if someone is paying for a Busi-

ness License, you might want something special noted on the receipt.  You can

create a different receipt for Business Licenses and attach it to print only with this

Type Code.

l Slips are created on the Slip Maintenance window (CR> Maintenance> Slip).

l
Click the Create icon drop-down menu and select New Slip to select a slip from

a list.

l Each Slip can be given its own Print Order so you know when the printer will be

printing receipts and when you should put anything in the printer that needs an

endorsement.  This information is entered into the Print Order column next to the

Slip Name.

l For example, you may want to print a standard receipt, a Business License

receipt, and then endorse a Business License document.  In this case, the

standard receipt would be Print Order 1, the Business License receipt would

be Print Order 2, and the special endorsement for Business Licenses would

be Print Order 3.

4     Attach a Tax to the type code. 

l Taxes can be attached to Standard type codes by adding a Tax Type to the type

code.
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l
Click the Create icon drop-down menu and select New Tax Type to select a tax

type code from the Type Code Selection window.

l Only those type codes set up as Tax type codes will be displayed. If no type

codes are displayed, you will need to create a tax type code.

l
Click the Confirm icon to attach the tax type to the type code.

l Type codes with attached tax types will create two line items when added to a

receipt.

l
Click on the Save icon when you are complete to save the type code.
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CR> Maintenance> Type Code

UB Deposit Type Code Maintenance

Summary

A Cash Receipts module type code can be used to create a UB module cash deposit from

the Cash Entry window. Create a UB fee code (UB> Maintenance> Fee Code) and check

the Deposit toggle on the Fee Code Maintenance window to define the fee code as a

deposit. After the UB deposit fee code has been created, create a CR module type code

with a type code that is identical to the fee code. The GL accounts and UB module inform-

ation of the deposit will be pulled from UB fee code. Check the UB Deposit Type toggle on
the CR type code (CR> Maintenance> Type Code). When a receipt is created, add the CR

type code on the Detail tab of the Cash Entry window to create the deposit.

Step by Step

1     Open the Type Code Maintenance window (CR> Maintenance> Type Code). 

l Create a new type code.

l Press INSERT to create a new type code. You can also create a new type
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code by clicking on the Create icon . This will open the Type Code Main-

tenance window.

2     Complete the Type Code Maintenance window. 

l Enter a Type code.

l The type code entered in this field must match the fee code set up in the UB

module.

l The type code can be up to 20 alphanumeric characters long, but the fee code

in UB is limited to six alphanumeric characters long.

l Enter a Description of the type code.  This field can be up to 25 alphanumeric char-

acters long. The description of the type code does not have to be the same as the

description on the deposit fee code (UB> Maintenance> Fee> Description field).

l Enter the deposit amount in the Amount field. The amount entered on the type code

will overwrite the deposit amount entered on the UB fee code when the receipt is

generated.

l Check the UB Deposit Type toggle.

l The Debit Account and Credit Account fields will be disabled because the GL

accounts used on the cash deposit transaction will be pulled from the UB fee

code.

l
Click the Save icon when complete.
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CR> Report> Batch Summary Report

Batch Summary Report

Summary

The Batch Summary Report is used to display Cash Receipts batches grouped by work-

station or operator. The report contains the batch number, batch date, batch status (com-

mitted or uncommitted), number of receipts in the batch and batch total.  Each batch

displays on the report as a single line item, so the report does not display the receipt detail.

Step by Step

1     Open the Print Batch Summary Report window (CR> Reports> Batch Summary).

2     Configure the report. 

l The Batch From and Batch To fields are used to select a specific Cash Receipts

batch or a range of batches.  Click the Batch From or Batch To field labels to find an

existing batch. This will open a Batch Selection window. If you leave the fields

empty, the report will display all batches that fall within the other criteria selected on

this screen.
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l The Date From and Date To fields are used to filter the receipts that display on the

report by receipt date.

l The batch totals on the Batch Summary Report will only include receipts that

have been included on the report. If the receipt date of the receipts in a batch

vary, filtering the report by receipt date may exclude receipts from a batch.

This means the Batch Summary total will not equal the total receipts in the

batch. For example, if an over/short type code receipt was entered with a

receipt date of 07/02/15, but all of the other receipts in the batch have a

receipt date of 07/01/15, filtering the batch by receipt date 07/01/15 will

exclude the over/short adjustment from the report.

l The Total By drop-down menu is used to select how you would like the report the

total.

l The Station drop-down menu is used to filter the receipts that display in the report

by the station that was used to generate the receipt. Select a station from the drop-

down menu to include only receipts generated on that workstation on the report.

l Stations are created and maintained in the Station Maintenance window (CR>

Maintenance> Station).

l The Operator drop-down menu is used to filter the receipts that display on the

report by the operator that entered the receipt. Select an operator from the drop-

down menu to view only receipts entered by that operator.

l Cash Receipts module operators are creating and maintained in the Operator

Maintenance window (CR> Maintenance> Operator).

l The Receipt Status drop-down menu is used to filter the receipts that display on

the report by void status.
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l Select Valid if the report should only include receipts that have not been

voided.

l Select Void if the report should only include receipts that have been voided.

l Select All to include receipts of all statuses on the report.

l The Commit Status drop-down menu is used to filter the receipts that display on

the report by the commit status of the batch they have been generated in.

l Select Committed if only committed receipts should display on the report.

Receipts are committed when the Commit step of the Cash Receipts palette

(CR> Cash Receipts> Commit) is complete.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Cash Drawer Report

Cash Drawer Report

Summary

The Cash Drawer Report displays a list of receipts grouped by either operator or work-

station and can be filtered by receipt date, batch number, receipt commit status, void

status, station and operator.

If the report is processed in Detail format, the report displays the receipt and payment type

total for each receipt included in the report. If the report is processed in summary format,

the report only displays the total receipts by payment type.

The Cash Drawer Report will not display the detail line items on each receipt. If you would

like to view the detail line items, generate a Receipt Listing Report (CR> Reports> Receipt

Listing).

Step by Step

1     Open the Cash Drawer Report window (CR> Reports> Cash Drawer Report).

2     Configure the report. 
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l Click the Batch field label to select a CR module Cash Receipts batch from a list

and filter the report by a batch. This will open the Batch Selection window.

l There is a filter on the Batch Selection window that allows you to filter the

batches that display in the window by committed and uncommitted batches.

l Select the level of detail you would like to display on the report in the Type drop-

down menu.

l The Detail report will display the receipt number, customer number, receipt

amount, change returned to the customer and total receipt for each receipt

included in the report.

l The Summary report will display receipts totaled by payment type rather than

the total of each receipt.

l Enter a date in the Date From and/or the Date To fields to filter the report by receipt

date. This will filter the receipts that display in the report by receipt date.

Press DELETE to remove a date from a date range field.

l When receipts are created, the receipt date is entered in the Date field in the

Receipt Information section on the Cash Entry window in the Cash Receipts

module.

l Select how you would like receipts grouped and totaled in the Total By field.

l Select an Operator from the drop-down menu to group and total the receipts

that display on the report by CR module operator. This will group the receipts

by operator and then by station. All of the receipts entered by an operator, no

matter which station was used to enter the receipt, will be totaled together by

payment type in a summary section. The report will also display report totals

of each payment type.
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l CR module operators are set up on the Operator Maintenance window

(CR> Maintenance> Operators).

l Select a CR module station from the drop-down menu to group and total the

receipts that display in the report by a CR module station. This will group the

receipts by station and then by operator. All of the receipts entered on a sta-

tion, no matter which operator created the receipt, will be totaled together by

payment type in a summary section. The report will also display report totals

of each payment type.

l CR module stations are set up on the Station Maintenance window

(CR> Maintenance> Stations).

l Select a Station in the drop-down menu to filter the receipts that display on the

report by the station that was used to create them.

l Select an Operator in the drop-down menu to filter the receipts that display on the

report by the operator that created the receipt.

l The Receipt Status drop-down menu is used to select the status of the receipts

that display on the report.

l Select Valid to include only valid receipts on the report. Valid receipts are

receipts that have not been voided.

l Select Voided to include only voided receipts on the report.

l Receipts are voided in the Enter Receipts window (CR> Cash

Receipts).

l Select the Commit Status of the receipts you would like to display in the report in

the drop-down menu.

l Select Committed in you only want to include committed receipts on the

report. Receipts are committed in CR> Cash Receipts> Commit.
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l If you selected a committed or uncommitted batch in the Batch field, you do

not have to select a commit status from the drop-down menu.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l If the report has been printed in detail, the report will display the receipt number,

void status, customer number, payment method, change on the transaction and the

receipt amount.

l The report will display all of the receipts in the report totaled by payment type

and will total either by station or operator.
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l If the report has been printed in summary format, it will only display the receipts

totaled by payment type and grouped by either station or operator. The summary

version of the report will not display individual receipts.
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CR> Reports> Category List

CR Category List Report

Summary

The Category List Report displays a filtered list of category codes (CR> Maintenance> Cat-

egory) and the types codes (CR> Maintenance> Types) grouped into those category

codes. The report will display the default amount of each type code and can be filtered to

include a range of category codes.

Step by Step

1     Open the Category List window (CR> Reports> Category List Report).

2     Configure the report. 

l Select a category in the From and To fields to filter the categories that display in the

report. All categories included in the range will display in the report.

l Categories display in the drop-down menu in alphabetical order.

l If you want to print the report for a single category, select that category in both

the From and To fields.
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l All categories set up in the Cash Receipts module will display in the drop-

down menu.

l Categories are set up on the Category Maintenance window (CR> Main-

tenance> Categories).

l An information window will open if you select a category in the From field that

is after the category in the To field.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

CR CATEGORY LIST REPORT 200



l The report will display the category code, category description, type code, type

code description, type code amount and category code total. The report will also

include a report total.
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CR> Reports> Deposit Slip

Deposit Slip Report

Summary

The Deposit Slip Report is used to help create a bank deposit slip for the cash and check

receipts of a selected day. If you do not deposit receipts daily, you can run the report mul-

tiple times and then add together the total deposit amounts from each report. The report dis-

plays uncommitted transactions in case you commit Cash Receipts batches after you

generate the deposit slip. Receipts that have been voided are excluded from the report.

Receipts of payment type Other are excluded from the report so that the Deposit Slip

Report does not include credit card receipts. All receipts paid with cash will be totaled on

the report and each receipt paid with a check will be individually listed on the report.

Checks and cash are totaled separately on the report.

Payment types are set up as cash, check or other in CR> Maintenance> Payment Type

and the payment type is attached to a receipt in the Payment Information section of the

Cash Entry window.

Step by Step

1     Open the Deposit Slip window (CR> Reports> Deposit Slip).
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2     Configure the report. 

l Enter a date in the Receipt Date field.

l The receipt date is the date on the receipt, not necessarily the date the receipt

was posted to the general ledger. The receipt date is entered in the Date field

in the Receipt Information section of the Enter Cash Receipt window.

l Check the List Checks toggle if you want each check listed separately on the

report. The check number of each check will display on the report.

l Payments are considered checks if the payment type used on the receipt is

set up as a check. Payment types are set up in CR> Maintenance> Payment

Type, and designated as cash, check or other in the Type drop-down menu.

l The check number that displays on the Deposit Slip Report is pulled from the

Reference field in the Payments section of the Cash Entry window.

l Operators are not required to enter a value in the Reference field when

entering cash receipts.

l If you do not check the List Checks toggle the report will only display the

check total at the bottom of the report.

l If you want the total of all cash and checks on the report, put a check in the Show

Grand Total toggle.

l If you do not check the Show Grand Total toggle the report will display a sep-

arate total for cash and check receipts and will not total the cash and check

receipt amounts together.

DEPOSIT SLIP REPORT 203



3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Pay Method Listing Report

Pay Method Listing Report

Summary

The Pay Method Listing Report will group and total a filtered list of receipts by the payment

method entered on the receipt. Payment methods are created and maintained in CR> Main-

tenance> Pay Method, and are attached to receipts in the Pay Method field of the Cash
Entry window. The report displays the receipt number, receipt date, payment method, oper-

ator, station, amount and change. The change column is the amount of change returned on

the transaction.

Step by Step

1     Open the Payment Method Listing window (CR> Reports> Pay Method Listing).

2     Configure the report. 

l Click the Batch field label to select a batch from a list and filter the report by the

receipts of a specific batch. This will open the Batch Selection window, which will

display both committed and uncommitted Cash Receipts batches.
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l The Pay Method drop-down field is used to filter the transactions included on the

report by pay method.

l Enter a date range in the Date From and Date To fields to filter the receipts that dis-

play in the report by receipt date. The receipt date is not necessarily the same date

that the receipt is posted to the general ledger. Press DELETE to remove a date

from the field.

l The receipt date is entered in the Date field in the Receipt Information section

of the Cash Entry window.

l This date range is limited to a total of 95 days in order to prevent performance

issues that could arise when the system attempts to access a very large

amount of data.

l Select a Station from the drop-down menu to filter the receipts that display in the

report by the station that was used to create it.

l Stations are set up on the Station Maintenance window (CR> Maintenance>

Stations).

l Select an Operator from the drop-down menu to filter the receipts that display in the

report by the operator that created it.

l Operators are set up on the Operator Maintenance window (CR> Main-

tenance> Operators).

l The Receipt Status drop-down menu is used to select the status of the receipts

that display on the report.

l Select Valid to include only valid receipts on the report. Valid receipts are

receipts that have not been voided.

l Select Voided to include only voided receipts on the report.
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l Receipts are voided in the Enter Receipts window in CR> Cash

Receipts.

l Select the Commit Status of the receipts you would like to display in the report in

the drop-down menu.

l Select Committed in you only want to include committed receipts on the

report. Receipts are committed in CR> Cash Receipts> Commit.

l If you selected a committed or uncommitted batch in the Batch field, you do

not have to select a commit status from the drop-down menu.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l In order to prevent performance problems, only one Pay Method Listing report can

be run at any given time. If another user is already attempting to generate the

report, you will receive an error message and will need to regenerate the report at a

later time.
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CR> Reports> Payments by System

Payments by System Report

Summary

The Payments by System report displays a filtered list of payment receipts that be filtered

by system, date or status. You can also limit the report results to only those entered at a

specific cash receipts station or by a specific operator.

Step by Step

1     Open the Payments by System report window (CR> Reports> Payments by System).

2     Configure the report. 

l Select a Report Type from the drop-down menu.

l The Summary report will display the System, Type/Fee, Amount, system sub-

total and report total.

l The Detail report will display everything included in the Summary report as

well as the Receipt Number, Customer Number, Name, Description, Date,

Void status and Amount for each line item.
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l Enter a Batch Number or click the field label to select one from a list.

l The Rcpt Date From and Rcpt Date To fields are used to filter the report by a spe-

cific receipt date range.

l The Commit Status drop-down menu is used to specify whether the report will

include committed, uncommitted or all payment data.

l The Receipt Status drop-down menu is used to specify whether the report will

include valid, voided or all receipts.

l Voided receipts will display a large red VOID in the Receipt Information sec-

tion on the receipt (CR> Maintenance> Display Receipts).

l The Operator drop-down menu is used to filter the report results by the operator

associated with the payment.

l Operators are created and maintained on the Operator Maintenance window

(CR> Maintenance> Operator).

l The Station drop-down menu is used to filter the report results by the station used

to enter the payment.

l Stations are created and maintained on the Station Maintenance window

(CR> Maintenance> Station).

l The Systems field is used to filter the report by the selected systems. Check the

toggle next to each system you would like to include in the report.

3     Print the report. 
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Receipt Listing Report

Receipt Listing Report

Summary

The Receipt Listing Report will display a filtered list of receipts with the receipt amounts

grouped by payment type (cash, check, other), change returned on the transaction, net

cash paid on the transaction and the total transaction. The report will not group the pay-

ments by pay method (CR> Maintenance> Pay method). When a pay method is selected

on the Cash Entry window, the payment type attached to the selected pay method will be

used to group the transaction amount on the report. Payment types are attached to pay

methods in the Type drop-down menu on the Pay Method Maintenance window (CR> Main-

tenance> Pay Method).

If the Receipt Listing Report is generated in detail format, the detail line items on the

receipt will display on the report.

Step by Step

1     Open the Cash Receipts Listing window (CR> Reports> Receipt Listing).

2     Configure the report. 
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l Select the level of detail you would like to display on the report in the Report Type

drop-down menu.

l The Summary option will display the receipt number, whether or not the

receipt has been voided, customer account number, date, customer name

and the dollar amounts by Cash, Check, Other, Change, Net Cash and Total.

l The Detail option will display all of the information on the summary version of

the report plus the detail line items on the receipt on the report. The individual

line items include the type code, line item description and the GL credit

account on the line item.

l Some of the filters in the Cash Receipts Listing window will filter the report by

receipt line item and others will filter the report by receipt. If you filter the

report by a receipt line item but print the report in summary format, the entire

receipt amount will display on the report, but only receipts that contain the

filtered receipt line items will be included.

l Select the order in which information will display on the report in the Sort By drop-

down menu.

l The Account Number field is used to filter the receipt line items that display on the

report by the GL account number attached to them. The receipt line item will be

included on the report if the GL account selected in the Account Number field is

used as either the debit or credit account on the detail line item. Even when printing

the Receipt Listing report in detail the report will only display the credit GL account

attached to the detail line item, so the report will not display the GL account number

if the GL account is the debit account on the receipt line item.
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l Click the Account Number field label to select a GL account from a list.

l The receipt line items will only display on the report if you print the report in

detailed format.

l The Batch Number field is used to filter the receipts that display on the report by

Cash Receipts batch.

l Click the Batch Number field label to select a Cash Receipts batch from a

list.

l The Receipt Number From and Receipt Number To fields are used to filter the

receipts that display in the report by receipt number.

l The receipt number range is limited to 10,000 receipts to prevent system per-

formance issues that can result from the report processing excessive

amounts of data.

l The Receipt Date From and Receipt Date To fields are used to filter the receipts

that display in the report by receipt date. Press DELETE to remove a date from the

date range fields.

l The receipt date defaults to the current date when a receipt is created using

the Cash Entry window. The receipt date will display in the Date field in the

Receipt Information section of the Cash Entry window.

l If you only enter a receipt date in the Receipt Date From field, all receipts

with a receipt date greater than the value in the Receipt Date From field will

display on the report. The Receipt Date To field functions in a similar way; all

receipts with a receipt date less than the value in the Receipt Date To field will

display on the report.

l The receipt date range is limited to 370 days to prevent system performance

issues that can result from the report processing excessive amounts of data.
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l Select a commit status from the Commit Status drop-down menu to filter the

receipts by commit status.

l Select Committed if only receipts in committed batches should display in the

report. Receipts in batches that have not been committed will not display on

the report.

l If a voided receipt is in a committed batch, the voided receipt will display

on the report unless voided receipts are removed from the report using

the Receipt Status drop-down menu.

l Select a Receipt Status from the drop-down menu. The report can be configured to

display Valid, Void or All Receipt Statuses.

l Select Void if you would like only voided receipts to display in the report.

l A VOID will display in the Void column of the report if you include voided

receipts on the report.

l The Operator and Station drop-down menus are used to filter the receipts that dis-

play in the report by the station the receipt was created on or the operator that cre-

ated the receipt.

l Operators are created and maintained on the Operators Maintenance window

(CR> Maintenance> Operators).

l Stations are created and maintained on the Station Maintenance window

(CR> Maintenance> Stations).

l The Categories field is used to filter the receipt line items by the category code

used to generate the receipt. Category codes are attached to receipts on using the

Account/Category tab of the Cash Entry window.

l Only receipts created using a category code will have a category code asso-

ciated with the receipt. If you select a category code in the Categories field
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only receipts generated by that category code will display in the report.

Receipts generated without using a category code will not display on the

report.

l If you select all of the category codes in the Categories field only receipts gen-

erated using category codes will display on the report.

l The category code will not display on the report. Only the type codes asso-

ciated with the selected category code will display on the report.

l The Types field is used to filter the receipt line items that display on the report by

the type code attached to the receipt. Type codes are attached to receipts using the

Detail tab of the Cash Entry window.

l If the receipt was generated using a category code the type codes associated

with the category code will be included on the report.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Receipt Listing by GL
Report

Receipt Listing by GL Report

Summary

The Receipt Listing by GL Report will display a filtered list of receipts grouped by GL

account. If the report is generated in detail format, the detail line items on the receipt will

display on the report.

Step by Step

1     Open the Cash Receipts Listing by GL window (CR> Reports> Receipt Listing by

GL).

2     Configure the report. 

l Select the level of detail you would like to display on the report in the Report Type

drop-down menu.
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l The Summary option will display the account number, account description

and amount for each line item. A report total will also be provided.

l The Detail option will display all of the information included in the summary

version of the report as well as receipt number, void status, customer number,

customer name, receipt date and line item description.

l Some of the filters in the Cash Receipts Listing by GL window will filter the

report by receipt line item and others will filter the report by receipt. If you filter

the report by a receipt line item but print the report in summary format, the

entire receipt amount will display on the report, but only receipts that contain

the filtered receipt line items will be included.

l Select the order in which information will display on the report in the Sort By drop-

down menu.

l The Account Number field is used to filter the receipt line items that display on the

report by the GL account number attached to them. The receipt line item will be

included on the report if the GL account selected in the Account Number field is

used as either the debit or credit account on the detail line item. Even when printing

the Receipt Listing by GL report in detail the report will only display the credit GL

account attached to the detail line item, so the report will not display the GL account

number if the GL account is the debit account on the receipt line item.

l Click the Account Number field label to select a GL account from a list.

l The receipt line items will only display on the report if you print the report in

detailed format.

l This is a required field. You must enter a full or partial GL account.

l The Batch Number field is used to filter the receipts that display on the report by

Cash Receipts batch.
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l Click the Batch Number field label to select a Cash Receipts batch from a

list.

l The Receipt Number From and Receipt Number To fields are used to filter the

receipts that display in the report by receipt number.

l The receipt number range is limited to 10,000 receipts to prevent system per-

formance issues that can result from the report processing excessive

amounts of data.

l The Receipt Date From and Receipt Date To fields are used to filter the receipts

that display in the report by receipt date. Press DELETE to remove a date from the

date range fields.

l The receipt date defaults to the current date when a receipt is created using

the Cash Entry window. The receipt date will display in the Date field in the

Receipt Information section of the Cash Entry window.

l If you only enter a receipt date in the Receipt Date From field, all receipts

with a receipt date greater than the value in the Receipt Date From field will

display on the report. The Receipt Date To field functions in a similar way; all

receipts with a receipt date less than the value in the Receipt Date To field will

display on the report.

l The receipt date range is limited to 95 days to prevent system performance

issues that can result from the report processing excessive amounts of data.

l Select a commit status from the Commit Status drop-down menu to filter the

receipts by commit status.

l Select Committed if only receipts in committed batches should display in the

report. Receipts in batches that have not been committed will not display on

the report.
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l If a voided receipt is in a committed batch, the voided receipt will display

on the report unless voided receipts are removed from the report using

the Receipt Status drop-down menu.

l Select a Receipt Status from the drop-down menu. The report can be configured to

display Valid, Void or All receipt statuses.

l Select Void if you would like only voided receipts to display in the report.

l A VOID will display in the Void column of the report if you include voided

receipts on the report.

l The Operator and Station drop-down menus are used to filter the receipts that dis-

play in the report by the station the receipt was created on or the operator that cre-

ated the receipt.

l Operators are created and maintained on the Operators Maintenance window

(CR> Maintenance> Operators).

l Stations are created and maintained on the Station Maintenance window

(CR> Maintenance > Stations).

l The Categories field is used to filter the receipt line items by the category code

used to generate the receipt. Category codes are attached to receipts on using the

Account/Category tab of the Cash Entry window.

l Only receipts created using a category code will have a category code asso-

ciated with the receipt. If you select a category code in the Categories field

only receipts generated by that category code will display in the report.

Receipts generated without using a category code will not display on the

report.

l If you select all of the category codes in the Categories field only receipts gen-

erated using category codes will display on the report.
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l The category code will not display on the report. Only the type codes asso-

ciated with the selected category code will display on the report.

l The Types field is used to filter the receipt line items that display on the report by

the type code attached to the receipt. Type codes are attached to receipts using the

Detail tab of the Cash Entry window.

l If the receipt was generated using a category code the type codes associated

with the category code will be included on the report.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Type Code

Type Code Report

Summary

The Type Code Report allows the user to print a detailed range of information for each type

code created in the application. Use this report to display the relationship between indi-

vidual type codes and a user-defined range of receipts.

Step by Step

1     Open the Type Code Report window (CR> Reports> Type Code).

2     Configure the report. 

l Select a Report Type for the report.

l The Summary Report will display the Receipt Number, Void status, Customer

Number, Date and Type Code Listing Name. The report will also provide a

report total.

l The Detail Report will display all the information included in the Summary

report as well as the Type Code, Description and Amount.
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l Use the Sort By drop-down menu to specify how the report will be organized. The

report can be sorted by Customer Number, Date or Receipt Number.

l Enter a Batch Number or click the field label to choose one from a list.

l Enter a date range in the Rcpt Date From and Rcpt Date To fields to filter the

report output by date range.

l Select a Commit Status from the drop-down menu. The report can be configured to

display Committed, Uncommitted or All Commit Statuses.

l Select a Receipt Status from the drop-down menu. The report can be configured to

display Valid, Void or All Receipt Statuses.

l Select an Operator from the drop-down menu. Only user accounts that are set up to

enter cash receipts will display on this drop-down menu.

l Operator accounts are created and maintained on the Operator Maintenance

window (CR> Maintenance> Operator).

l Select a Station from the drop-down menu. Only workstations that are set up to

enter receipts will display in this drop-down menu.

l Stations are set up and maintained on the Station Maintenance window (CR>

Maintenance> Station).

l Specify which type codes to include in the report by checking the desired toggles in

the Types section.

l Type codes are created and maintained on the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

3     Print the report. 
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Reports> Type List

CR Type List Report

Summary

The Type List report will display a list of type codes and type code information including the

type code, type description, GL account numbers associated with each type code, and the

dollar amount of the type code. All type codes, including those that are inactive, will display

on the report. The Type List Report will not display the Project Management module task or

type code attached to the type code.

Type codes are set up in CR> Maintenance> Type Code Maintenance and attached to a

receipt in the Cash Entry window by clicking the Create icon on the Details tab.

Type codes can be grouped into categories in CR> Maintenance> Category Maintenance.

Those type codes that are grouped into categories will display on the Category List Report

in CR> Reports> Category List.

Step by Step

1     Open the Print Type List window (CR> Reports> Type List).
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2     Configure the report. 

l Select a type code in the From and To fields to filter the categories that display in

the report. All type codes included in the range will display in the report.

l Type codes display in the drop-down menu in alphabetical order.

l If you want to print the report for a single category, select that type code in

both the From and To fields.

l All type codes set up in the Cash Receipts module will display in the drop-

down menu.

l Type codes are set up on the Type Code Maintenance window (CR> Main-

tenance> Type Code).

l An information window will open if you select a type code in the From field

that falls alphabetically after the category in the To field.

l The Type List Report will display the type code, type code description, debit and

credit GL account, and the amount of the type code. The report will also include a

report total.

l The debit and credit GL accounts are set up on the type code in CR> Main-

tenance> Type Code> Debit and Credit fields.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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CR> Utilities> Setup Cash Receipts

Set up the Cash Receipts Module

Summary

The Setup window in CR> Utilities> Setup is used to set up how the Cash Receipts module

will function.

Step by Step

1     Open the Cash Receipts Setup window (CR> Utilities> Setup).

2     Complete the General tab. 

l Check the Auto Number Receipts toggle if you want each receipt created in the

Cash Entry window to automatically be assigned a receipt number using the next

available receipt number. If you would like to enter a receipt number on each

receipt, do not check this toggle.
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l If the Auto Number Receipts toggle is checked, the Receipt Number field on

the Cash entry window will not be enabled.

l If you would like the receipts to begin at a certain receipt number, uncheck the

Auto Number Receipts toggle, create a receipt in the Cash Entry window

using the receipt number you would like the receipt numbers to being with,

and then check the Auto Number Receipts toggle. Receipt generated after the

toggle has been checked will have receipt numbers that follow the manually

entered receipt number.

l Check the Allow Zero Amount Receipts toggle if you want to allow receipts with a

net amount of zero. Zero amount receipts are generally used to adjust the type

codes used on CR receipts that have been committed.

l Check the Allow negative amount receipts toggle if you want to allow negative

amount receipts. This is generally used to enable negative receipts in the Cash

Entry window created using CR module type codes (CR> Maintenance> Type

Codes).

l This feature has two general uses: over/short cash drawer adjustments in a

Cash Receipts batch, and recording bank fees.

l Create a type code to record over and short amounts on a cash drawer.

When the cash drawer is counted, create a receipt in the batch using

the over/short type code to record the over/short amount. This will bring

the Cash Receipts Proof List into balance with the cash drawer.

l Create a type code to record bank fees. When a bank fee is assessed,

create a receipt in a Cash Receipts batch. The fee amount will display in

the Bank Reconciliation module so that the bank accounts will be in bal-

ance.
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l This feature should not be used to make adjustments on customer

accounts. Type code transactions will not create a history item on a cus-

tomer account, so adjustments to customer accounts should be pro-

cessed through the module in which the invoice was created.

l Check the Single operator per batch toggle if only one CR operator should create

receipts in a single Cash Receipts batch (CR> Cash Receipts). This option is gen-

erally only used by organizations that access the Cash Entry window from the Cash

Entry menu option on the Cash Receipts palette. If users access the Cash Entry win-

dow using the Enter Receipts menu option, users will be able to open and modify

receipts that have been created by other users in the batch but they will not be able

to create new receipts.

l This setup option only limits the creation of receipts inside a Cash Receipts

batch, it does not limit the creation of new batches.

l The single user of a batch is set when a receipt is entered in a batch. Before a

receipt is entered in a batch any user can open and access the batch. This

allows a manager or user to create batches, but another user to enter receipts

in that batch.

l CR operators that are set up as Managers will still be able to create new

receipts in batches created by all other operators. CR operators are set up as

managers by checking the Manager toggle CR> Maintenance> Operator>

Maintenance section.

l If you select this option you should also limit access to the Display Receipts

window (CR> Maintenance> Display Receipts) because uncommitted

receipts in any open Cash Receipts batch can be modified from that window.

You can set menu security on the Display Receipts window using the Menu

Security window (SS> Security> Menu Security).
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l Check theWarn if GL DR/CR Account same on detail toggle if you would like an

alert window to open when a receipt is saved that has a receipt line item with the

same GL account set up for the debit and credit account. This feature helps prevent

creating a transaction line item that is a wash.

l Checking this toggle will only cause an information window to open, it does

not prevent the line item from being saved.

l If there are multiple line items on a receipt that create a net wash on the trans-

action, the information window will not open. This toggle only applied to single

line items on the receipt.

l Check the Show General Ledger accounts toggle if you want the General Ledger

account numbers to display on the Details tab of the Cash Receipts Entry window.

This will display the debit and credit account on each line item on the receipt.

l Check the Enable multi-bank deposits toggle to use the multi-bank deposits fea-

ture. The selection in this toggle will affect the validation of the Cash Entry window

in the Cash Receipts module and Receipt Deposits process in the Bank Recon-

ciliation module (BR> Receipt Deposits).

l The multi-bank checking feature is used to associate GL cash accounts with

specific bank accounts. Bank accounts are associated with GL accounts on

the Associate Reimbursements window (SS> Maintenance> Associate Reim-

bursements). The multi-bank deposits feature is used to create deposit trans-

actions in the Bank Reconciliation module using the bank accounts

associated with the GL cash account on the receipt line items. When the

Enable multi-bank deposits toggle is checked, the Cash Entry window will val-

idate to make sure that each GL cash account on a receipt line item (the GL

account debited by the line item) is associated with a bank account in the

Accounts Payable module. When deposits are created from the Cash
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Receipts module batches in the Receipt Deposits process (BR> Receipt

Deposits), the deposit transactions will be created on the bank accounts asso-

ciated with the GL cash accounts on the receipt line items.

l If the Enable multi-bank deposits toggle is not checked, the Cash Entry win-

dow will not validate to confirm that the GL cash accounts on receipt line items

are associated with bank accounts. In this case, the user will be able to select

the bank where the deposit transactions will be created in the Receipt Depos-

its process.

l You can associate multiple bank accounts with multiple GL accounts on the

SS Associate Reimbursements window (SS> Maintenance> Associate Reim-

bursements).

l Check the Project Management (PM) Interface toggle if you will be using the Pro-

ject Management module in conjunction with Cash Receipts. This will add a Project

Management Distribution List to the reports in the Cash Receipts batch process. If

you are not sure if you will be using Project Management in conjunction with Cash

Receipts, put a check in the box so that the PM Distribution report will be available if

needed. If you do not have a check in the box, the report will not be available in the

Cash Receipts process and Project information entered into the Cash Receipts mod-

ule will not post to the Project Management module.

l Check the Show Project Management (PM) info toggle if you want the Project

Management Task and Type codes to appear on the Detail tab of the Cash Receipts

Entry window. This will add the four columns to the Detail tab of the Cash Receipts

Entry window: Debit Task, Debit Type, Credit Task and Credit Type. The values in

those fields can be modified.

l If this toggle is not checked, but the Project Management Interface toggle is

checked, the Project Management task and type codes will still be passed to
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the Project Management module, but they will not display in the Enter Cash

Receipts window.

l This toggle is only available when Project Management Interface toggle is

checked.

l Check the Require operator reauthentication toggle if you want to require cash

receipts operators to re-enter their login credentials before opening the Cash Entry

window.

l When this toggle is checked, CR operators will log in to the application as

usual, but will be prompted to log in again when attempting to open the Cash

Entry window. This provides an additional level of security.

l Check the Enable KVS tax interface toggle to enable Springbrook's interface with

the KVS tax system.

l This will enable the KVS Tax Interface URL and KVS Tax Type Code fields to

the right. This will also enable the KVS Tax Search window, accessible

through the Enter Receipts window.

l Enter aWarning Threshold if you would like the system to warn users when they

are attempting to save a receipt with a receipt date that falls outside of the specified

date range.

l For example, enter 365 if users should be warned before saving receipts with

receipt dates that fall more than one year in the past or future.

l The maximum threshold is 10 years - 3,650 days.

l Select a Default Payment Method from the drop-down menu. When a receipt is

generated in the Cash Entry window, the default payment method will populate on

each payment line item. This is just a default value and can be modified as the pay-

ment is received. For example, if you select CASH as your default payment method,
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CASH will populate on each payment line item made in the Cash Entry window. If

the payment is made by check, the user will be able to modify the selection from

CASH to CHECK. Select the payment method that you use most often in order to

reduce data entry.

l The KVS Tax Inteface URL and KVS Tax Type Code fields are used to set up the

interface between Springbrook and the KVS Tax System. These fields will only be

enabled if the Enable KVS tax interface toggle is checked and must be populated to

enable the interface.

l The KVS Tax Interface URL field is used to enter the URL of the web service

interface that communicates with the KVS system. This URL will be provided

by Springbrook during the implementation of the interface.

l The KVS Tax Type Code field is used to specify a Springbrook type code that

will be used to track all KVS tax-related activity.

l This is a misc. type code that will be used to create receipts in Spring-

brook. Most users will create a new type code, perhaps named some-

thing like KVSTAX, to fulfill this purpose. When attaching GL accounts

to this type code, be aware that they will be overridden by the GL

accounts specified in the KVS Tax system.

l The Provide Full Detail for field is used to select which ALFRE designations will

create full detail journal entries when receipts are generated in CR Cash Receipts.

l The ALFRE designation of a GL account type is set up in GL Maintenance

Account Type. You can view which account type is attached to a general

ledger account in GL> Maintenance> Chart of Accounts> General tab>

Account Type field.
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l Highlight the ALFRE designations that you would like to create detailed

journal entries. You can select more than one ALFRE designation by holding

down CTRL or SHIFT while highlighting your selections.

3     Set up an optional credit card terminal. 

l The Card Terminals tab is used to configure an optional point-of-sale credit card ter-

minal that allows users to generate credit card terminal payments directly in Cash

Receipts. Organizations that would like to use the credit card interface will need to:

l Implement CivicPay, Springbrook's payment processing solution.

l Establish a Merchant Agreement with Bluefin, Springbrook's credit card pro-

cessing partner.

l Purchase the PAX A80 credit card terminal from Bluefin.

l Once these prerequisites are complete, the settings on this tab can be configured

with assistance from Springbrook. Please contact the Springbrook Support Team

for more information on setting up a credit card terminal.

4     Track any changes made to the CR Setup window. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit trail.
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l The Audit Trail History section will provide details about any changes made to the

setup window including the date of the change, type of change made, user that

made the change, and data table that was edited.

l
Click the Save icon when the setup is complete.
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CR> Utilities> Audit Trail

CR Audit Trail

Summary

The Audit Trail window is used to track any changes made to a CR receipt.

Step by Step

1     Open the Audit Trail window (CR> Utilities> Audit Trail).

2     View the receipt audit history. 

l Use the Search Criteria section to sort the displayed receipts and the associated

audit history. Once you have specified the search criteria, click the Refresh icon

to display the matching receipts.

l The Audit Trail section will provide details about any changes made to a receipt

including the date of the change, type of change made, user that made the change,

the receipt number that was edited, and the data table that was edited.
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CR> Utilities> Receipt Date Update

Receipt Date Update Tool

Summary

The Receipt Date Update tool is used to update the receipt date for miskeyed receipts in

committed Cash Receipts batch. As with any other changes made to a receipt, updating a

miskeyed receipt date will create an entry in the receipt audit trail.

Step by Step

1     Open the Receipt Date Update window (CR> Utilities> Receipt Date Update).

2     Update the miskeyed receipt dates. 

l Enter the Cash Receipt Batch that contains the erroneous receipt or click the field

label to select the batch from a list.

l Enter the Incorrect Receipt Date and the Correct Receipt Date for the desired

receipt.

l
Click the Confirm icon to update the receipt date.
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l The receipt date will be updated and the update transaction will appear on the

receipt audit trail (CR> Maintenance> Display Receipts> View Audit Trail icon ).
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CR> Utilities> Activity Details Export

Export CR Activity Detail Data

Summary

The Activity Details Export window is used to generate an export file that includes CR activ-

ity information related to revenues received by the organization. This export file is designed

to help organizations meet state auditing requirements.

Step by Step

1     Open the Activity Details Export window (CR> Utilities> Activity Details).

2     Configure and generate the export file. 

l Specify a journal entry date range in the Check Date From and Check Date To

fields.

l
Click the Display icon to display the expected .csv file layout. The export file will

include customer, batch, receipt, GL account, payment and operator data.

l
Click the Confirm icon to generate the export file.
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l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the Activity Details file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l
Enter the export path location and click the Save icon to export the file to

the local path.
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